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Contact AUSOM
Phone between 9 am and 9 pm only, please, unless other 
times shown. 
Office AUSOM 0421 126 175
Committee of Management
President: John Sullivan� president@ausom.net.au 
Vice President: Ivan Radywonik� vice-president@ausom.net.au 
Secretary: Susan Jensen� secretary@ausom.net.au 
Treasurer: Julie Ackland� treasurer@ausom.net.au 
Greg Davies� publicity@ausom.net.au 
Peter Emery� com@ausom.net.au 
John Stewart� com@ausom.net.au 
 

AUSOM News
Distribution:� office@ausom.net.au
Assistant Editors: Alan Brown, Rene Heeps, Mervyn Hayman-
Danker and Monty Maizels
Index: Peter Hunter and Ralph Learmont
Download AUSOM News: www.ausom.new.au/ausomnews

Exchange Table
Colette Connolly and Lorraine Fransdonk
� library@ausom.net.au
Other — Lost Property� lost-found@ausom.net.au

One on One
Personalised Mac, iPod, iPad and iPhone training.
Sit at a Saturday meeting with an experienced user for patient, 
detailed assistance on virtually any topic. Bookings at least 48 
hours beforehand: email one-one@ausom.net.au or phone 0421 
126 175. Include your topic, the software and equipment you 
are using and the times that best suit you.

Services and SIGs
SIG coordinators email addresses are shown in the article 
'Special Interest Groups'. (Page 6 in print version). They are 
provided so you may offer help/ideas for the group or service. 
Members of Committee may be able to help with other queries.
Any advice given may not reflect the views of AUSOM, Apple 
or any other manufacturer, representing as it does the views and 
understanding of the person giving the advice.
FirstClass Bulletin Board (AUSOM's on-line Support Service): 
Subscription required for full access, see Becoming a FirstClass 
Subscriber towards the end of this publication.
www.ausom.net.au/firstclass

AUSOM's Website

AUSOM’s Home page 
has information needed 
immediately — the latest 
news from AUSOM, a summary 
of the most recent posts and files 
available for download.  

'Timely Tips' are added 4 or 5 times each month. 

‘Stop Press’ items for AUSOM members and Committee 
are posted here IMMEDIATELY. 

The Events tab explains our next face-to-face meetings. 
The SIGs tab details current Special Interest Groups 
where members who have a particular interest 
exchange ideas and learn together. 

First Class is where subscribers can hold conversations 
using posted messages. All AUSOM members can access 
SIG notes by using the guest login and password. 

Advice via email or over the phone may be sought from 
other members — look for  “AUSOM Help Desk”. 

Look for AUSOM News and Downloads where you can 
find every issue of AUSOM's own magazine.

Help with Mail on your Mac

Some great ‘how-to’ 
information from Apple 

Mail Connection Doctor can help 
explain why the Mail app isn't sending 
or receiving email on your Mac.
https://support.apple.com/en-us/HT204173

OR
https://support.apple.com/en-us/HT204075
Follow the above 
link if the Mail 
app on your Mac 
suddenly 
doesn't send 
or receive email.
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AUSOM Incorporated	 ABN 63 929 877 630
Reg.No:	 A0005646X
Snail Mail to virtual office:	 247 Flinders Lane, Melb. 3000
Phone: 	 Mobile: 0421 126 175
e-mail:	 office@ausom.net.au
(e-mail will be forwarded as appropriate)
Website:	 http://www.ausom.net.au
Twitter:	 http://twitter.com/ausominc
AUSOM News submissions	 Editor: Pam Doughty
 Post:	 Editor, 247 Flinders Lane, Melbourne 3000
 e-mail:	 editor@ausom.net.au
Send letters & editorial material to the Editor post or e-mail 
deadline 1st Saturday of month prior to publication month.
NOTE: There is no AUSOM News in January
©Copyright: Articles in AUSOM News are Copyright© by AUSOM 
Inc, unless otherwise specified, and may be reprinted by non-profit 
organisations provided credit is given to the source and a copy of the 
publication containing the article is sent to AUSOM Inc.

AUSOM Tweets
We’re using Twitter to keep you and the Apple world in touch 
with ideas, activities, events and newsworthy items. Go to 
twitter.com/ausominc. Or click the ‘Follow us on Twitter’ 
button on our home page. Even better, set up your own Twitter 
account (if you haven’t got one already) and follow AUSOM.
AUSOM on Facebook
‘Like’ us on Facebook for the latest news from AUSOM as well 
as Apple-related stories and other amusing and innovative tech 
posts hand-picked from all over the globe. Go to facebook.com/
ausominc or click on the link on our home page.
AUSOM on YouTube
To showcase our creative video aspirants and their copyright-
free material. Each entrant will be vetted by CoM, so write to us 
at com@ausom.net.au to organise a viewing.
Go to youtube.com/user/ausominc
AUSOM/iMUG graphics list
To subscribe to AUSOM/iMUG graphics list, go to http://mail.
imug.com.au/mailman/listinfo/mag_imug.com.au. This email 
list is a small community of users helping each other with web, 
graphics and publishing questions. Beginners welcome. It is 
a joint venture of iMug and AUSOM but you don't have to be 
a member of either group to join. If you want to speak to a 
human about this list email nick *at* artful.com.au

AUSOM News - see other details in box above
©Copyright: See details above
Views expressed in articles are the views of the authors and are 
not to be taken as the views of the Editor or of AUSOM Inc.
AUSOM accepts advertisements and articles in good faith 
but accepts no responsibility for advertising content or claims 
made about products. Contributing authors are responsible for 
correct acknowledgment and/or permission for use of non-
original material. Thanks to users of AUSOM’s FirstClass BBS 
who have given permission for use of their tips and hints.
Note to Contributors:
To distinguish publication contributions from private items 
please include a note such as ‘For Publication in AUSOM News’.
Preference is given to articles submitted as TEXT with 
independent 200 dpi PDF, TIF or JPG images via e-mail or on 
CD or DVD posted to the Editor. PLEASE clearly indicate if 
your article applies only to OS 9 or earlier — all articles relate to 
OS X (macOS) unless otherwise stated. (Similarly for iOS).
Advertising:
Advertising MUST be booked, by the copy deadline. Contact: 
Gary Lowen 0478 084 691    advertising@ausom.net.au
Copy format as advised by Gary.
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Shut Down or Sleep??

What's the best way to turn off my Mac? Should I 
Log Out, Sleep, or Shut Down? Or should I just close 
the lid on my MacBook when I've finished? 

There are many different ways to turn your Mac 
off and there is little benefit from choosing one 
option over another. 

When you have finished using a Mac you can do 
any of the following things: 
• Sleep. Choose Apple menu > Sleep. 
• Shut Down. Choose Apple menu > 

Shutdown and click Shut Down. 
• Log Out. Choose Apple menu > Log Out and 

click Log Out. 
• Close Lid. If you have a MacBook — this 

places your Mac in sleep mode. 
• Energy Saver. Leave the Mac alone and 

eventually it should sleep on its accord. 
Provided Computer Sleep is not set to Never 
via System Preferences. 

Most users choose to Sleep their Mac or leave it 
till it goes into sleep mode.
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John Sullivan: president@ausom.net.au

Committee News�

Welcome to this month’s edition of “From Your 
Committee”.

Last Call for Major Raffle
A major push for our Major Raffle for 2017. If have not 
bought tickets yet, please make sure to do so quickly as 
there is only one month to go. You are able to buy tickets 
on line, sorry that PayPal has caused a few problems 
but these are being sorted out. The prizes to be won are 
fantastic (see add later in the magazine — pp 22 and 23). 
Don’t miss out.

AUSOM Lanyards
The new lanyards have arrived and are available for 
purchase at the Sign-in Desk at New Hope. A bargain at 
only $5.

There is also other paraphernalia available so inspect 
what is available when you are signing in.

Mornington Group
I ventured down to visit the Mornington Group last 
month for the first time. It may be a small group 
compared to the New Hope group but the enthusiasm and 
friendliness is definitely unmatched. It was great to see 
so many members willingly helping other members with 
problems, offering useful tips and generally contributing 
to a great evening.

Ideas for Special Interest Groups
Are there any members who have ideas for new SIGs that 
we could run. Or maybe you would like to run one of 
your own. If you do have some ideas, we could organise 
times for the new SIGs. They do not have to run for the 
whole year — maybe just for one or two sessions. We 
would like to keep abreast of what the members want, so 
please let us know.

FirstClass — 24-hour Assistance
Remember that FirstClass is now the only forum that we 
have at AUSOM. If you are not a subscriber then you are 
able to obtain a guest pass to see what the forum is like. It 
is a great source of information as you have all the great 
minds of the subscribers to gather information. Look on 
the website for the guest pass link.

Editor's Note: See Page 7 (foot of the page) and page 47 
in AUSOM News for further details.

Everything Apple Group
We are still looking for a co-presenter to work with Peter 
Emery at Everything Apple. The new times next year will 
be Tuesdays @ 2:00. If you feel that you could help please 
let a committee member know.

AUSOM News
A GREAT milestone has been reached this month.

Pam Doughty has been the fantastic editor of the AUSOM 
magazine for twenty-five years. I am sure all members 
realise what a marvellous effort this has been. The tasks 
involved in putting together a magazine such as ours, to 
me, are mind boggling, Yet Pam has diligently performed 
the role of editor for all these years. I hope Pam realises 
just how much we do appreciate all her work. I think we 
are one of the few computer clubs that still has a magazine 
in our format.

WELL DONE PAM! We don’t know where we would be 
without you.

How to contact us
phone the office on 0421 126 175
email: office@ausom.net.au

Booking for One on One (Individual personalised 
training) at Saturday meeting: one-one@ausom.net.au

⌘

Pam Doughty

Santa's Lil Helper�
This app was recently announced and will take visitors on 
an augmented reality experience, transforming numerous 
Melbourne city sites, including Degraves Street, Howey 
Place and Federation Square, into Christmas scenes.

As Santa’s Lil Helper, you’ve found Santa’s lost phone. It’s 
up to you to use it to retrace his steps, search for clues and 
with the help of some new friends in the Merry Crew, find 
Santa and save Christmas! I certainly hope to be able to 
try to find Santa — will I see you there, too?

Santa’s smartphone uses Christmas magic to activate 
signage panels located in Melbourne city laneways. 
Simply point your phone at the colourful illustrations 
and watch them transform into interactive animated 3D 
characters and worlds that magically spring to life.

The app also works on your iPad.

It is easy to locate at: https://whatson.melbourne.vic.gov.
au/christmas/Pages/App.aspx

⌘
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Pam Doughty: editor@ausom.net.au

Editorial�

AUSOM News Cover
Thanks to Brad Smith for the cover design this month. 
Brad worked in Photoshop using licensed artwork. His 
cover really shines when viewed in the coloured PDF of 
your magazine.

A Special Thank You
I don't know how I would make your magazine and the 
supporting index available to you each month without 
the members named on Page 2 of AUSOM News — Alan 
Brown, Rene Heeps, Mervyn Hayman-Danker, Monty 
Maizels, Peter Hunter and Ralph Learmont — thank you.

There are others who have contributed regularly. The 
coordinators and members who provide notes from our 
SIGs and Satellite groups — thank you. Susan Jensen, 
Brad Smith and Gus van der Heyde who have provided 
an amazing selection of cover design this year — thank 
you. Looking at any magazine this year you will see an 
article from Dick Johnson, a tip from Ivan Radywonik, 
opportunities for you to take photos from Keith 
Bishop and a report from our main meeting by Judy 
Young. Thank you to these members and all the other 
contributors. I'm sure to have forgotten someone — I 
want to say a VERY special thank you to you, too. 

Command Key Icon
You've probably used it at least a few times today without 
ever knowing exactly what it is or what it's called. I'm 
talking about the strange, swirly square emblazoned on 
the Command key. So just what exactly is it, and who 
decided it would be the symbol for such an important 
key?

The shape itself, which has appeared in different forms 
for thousands of years in Europe, may have its origins in 
a heraldic symbol called the Bowen knot. As a glyph (just 
a fancy word for character or symbol), it goes by several 
different names including the Gorgon loop and Saint 
John's Arms.

The symbol has come to symbolize many things over 
the past 2,600 years or so, but it didn't become an iconic 
part of computing culture until 1984. The story goes that 
when Steve Jobs first saw the keyboard command list for 
MacDraw he was unhappy with the number of Apple 
logos cluttering up lists where the Apple symbol was 
displayed in the drop-Down menus showing keyboard 
shortcuts. He demanded that his team find a suitable 
symbol to replace it.

Apple's bitmap artist, Susan Kare, began browsing for 
a new icon and stumbled upon the familiar symbol, 
which is used on modern roadside signs in Scandinavia 

to highlight a point of interest or cultural heritage. She 
presented the symbol to the team, and the Command key, 
as we now know it, was born.

Place of Interest Sign, Oslo. 

Editor's Note: My apologies to the member who sent me 
this picture some time ago. Perhaps you will remind me 

who you are so I can acknowledge your observation.

Your discoveries can help others
When you find out how to make your life easier using one 
of your Apple products send an email to editor@ausom.
net.au describing your experience. No experiences are too 
trivial.

Maybe you purchased an item or service from someone 
who advertises in AUSOM News. I know you will have 
told them you read about them in AUSOM News. Did you 
consider telling your friends how useful you found their 
advice?

Do your children/grandchildren talk about 
coding?
Alan Brown has an article on page 38 this month— 
he sees the idea of “coding” as a way to attract young 
computer users, and their relatives, to join AUSOM.

If 'coding' is a complete mystery to you and you would 
like to know what the children are talking about an 
initiative called 'Hour of Code' can assist. Give it a go. If 
you are thinking 'this is not for me'; 'I would not be able 
to understand it' or 'I would fail' then I am happy to prove 
you wrong. I will be in the Café and willing to show you 
what is involved starting from about 1:00 to 1:30pm.

Best Wishes for the Holiday Season
A big thank you AUSOM for supporting one another 
during 2017.

I wish you all a safe and happy holiday and look forward 
to meeting again in early February. The February edition 
of AUSOM News should be on our website by 22nd 
January and the deadline for copy is January 6th 2018.

⌘
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Group Coordinators/Reporters

Special Interest Groups�

Special 
Interest 
Groups

Largely unedited reports from meetings and plans for this month. Times and presentations are  
correct at time of publication. For more up-to-date information check AUSOM's web site or  
contact the coordinator whose name is beneath the SIG title.  
If a report is not available, your coordinator may need YOUR help. Please offer assistance.

See Timetable on the back page or www.ausom.net.au/events for meeting venue details.

9:00am Sat. 2nd December

iMovie iOS/macOS	 Events Rm.
Chris McQuillen: imovie@ausom.net.au

December Session
Chris will demonstrate the video 
capture capabilities of an iPhone 
and how to create very sophisticated 
movies using third-party Apps on the 
iPhone or the iPad.

This session will cover the capability 
of the Camera app that comes with 
the iPhone/iPad and how to optimise 
its settings.

He will then demonstrate some 
aspects of the Filmic Pro App that 
extends the iPhone/iPad into a really 
smart video capture device.

Chris will introduce LumaFusion and 
LumaFX and demonstrate some of 
their video editing features.

November Session
We screened green-screen mini 
videos that members produced 
at home from the green-screen 
experience Tim set up at the October 
SIG. Chris then demonstrated the 
green-screen features of iMovie 11 
and iMovie 10. He also touched on 
how these effects can be created in 
Keynote and then exported to iMovie 
as a QuickTime file.

December Main Presentation
We will also be hosting the 
Digital Film Festival as the Main 
Presentation at 11.00am in the Events 
Room.

Moviemakers 2018
Tim and Chris will be presenting a 
combined one-hour SIG next year 
in the 9.00am time slot. It will be a 
magazine-type format with regular 
features and one-off segments that 
will inform and entertain you. We 
will cover Equipment, Software, 

Filming techniques and much 
more. There will something of 
interest for everyone regardless of 
editing software preferences and/or 
experience.

Internet Plus	 Function 2
Peter Emery: internet-plus@ausom.net.au

This SIG aims to utilise the Internet 
for the user needs, e.g., accessing RSS 
feeds; ordering photos online via 
Apple's Photo application or anything 
else related to the Internet.

Finder Fundamentals�  
� Function 1
Ivan Radywonik:  
� finder-fundamentals@ausom.net.au

Finder Fundamentals is intended 
primarily to assist absolute beginners 
learn about the MacOS Finder. It 
operates within a semi-structured 
format to demystify the Finder 
through familiarity with its tools, 
customisation of preferences and 
settings, unlocking hidden features 
and avoiding unproductive patterns 
of use.

We began this month with a 
discussion around hardware 
longevity and upgrade 
considerations, before moving on 
to using iCloud Drive, in particular 
the pros and cons of allowing iCloud 
Drive access to your Desktop and 
Documents folders.

The focus of this SIG is to work 
our way through the available tools 
and options for customising the 
Finder interface, thereby developing 
a workspace that may be used 
effectively. It is aimed at beginners 
and we will cover the same ground 
regularly, introducing new topics as 
we go. At some point the SIG will 
start over with a fresh account.

Please feel free to write with any 
topics you wish to have addressed in 
coming sessions.

10:00am Saturday

Final Cut Pro/Express	Events Rm.
Tim Gurrie: final-cut@ausom.net.au

Tim presented three sessions in the 
Final Cut Pro SIG for November.

The first session was Movie Maker 
news where he talked about 
the impact of  the High Sierra 
upgrade on Movie Makers and the 
introduction of the iPhone X.

The second session was “You be the 
Judge” where members of the SIG 
debated and scored a movie.

The third session completed the 
editing of green-screens in FCPX.

In December Tim will present Movie 
Maker News, “You be the Judge” and 
Colour Correction in FCPX. 

iWork	 Function 2
Pam Doughty: iwork@ausom.net.au

December
We are going to continue looking at 
combining use of the iWorks apps 
(Pages, Numbers and Keynote) with 
other apple products. We may not 
look at ALL the Apple products that 
are freely available for your Mac but 
will use Preview, Safari, Photos and 
Mail.
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In December we will also perform 
similar tasks with applications on the 
iPad or at iCloud.com 

Questions received in advance by 
email allow better preparation of 
an answer. Why not allow other 
AUSOM members to benefit from 
your discoveries by sharing your 
questions at SIGs rather than trying 
to waylay the presenter after the 
meeting? 

FileMaker	 Function 1
Bradley Bush: fmp@ausom.net.au

For most of this year the Filemaker 
SIG has been using a “workshop” 
rather than “demo” approach, 
slowly developing a music database 
developed by Brad. Members have 
enjoyed “learning by doing” as each 
month we added an additional 
feature, or refined or extended 
something done the previous month. 
A bit of a challenge has been the 
range of different FM versions in use, 
but these differences haven’t stopped 
us in our tracks.

November saw that project come 
to an end; next year we will use 
the same approach but probably 
get going on a new project. At the 
December meeting we will bring this 
year to a close addressing specific 
questions and issues members raise. 
So if you are coming in December, 
make sure you are ready with things 
you’d like to have explained!

Beginners	 Seminar Rm 2
Ron Webster: beginners@ausom.net.au
Basic Computer terminology: Bits 
& Bytes, Hard drives, RAM & ROM. 
What do they all mean?
Desktop, folders and files: What is 
what and where?
Operating System & applications: What 
are they and what do I need?
We hope to answer these and many 
more questions. This is a four/ five-
session course planned to run twice in 
the year.

11:00am Saturday

Main Presentation	 Events Rm.
vice-president@ausom.net.au

See Display Advertisement page 11.

12noon Saturday

News @ Noon	 Events Rm.
Club News and a chance to ask 
questions of AUSOM.

12:30pm Saturday

Lunch/Informal Networking�
An opportunity to ask questions and 
share ideas. 

1:30pm Saturday

iPad Coach 	 Events Rm.
Julie Ackland:� ipad-coach@ausom.net.au

We talked about Split Screen and 
Slide Over; best used on iPads of 
course.

Split Screen enables you to view two 
apps at the same time. I have found 
this works well with Notes and Safari 
for studying or Email and with Safari 
for viewing a mail message and the 
URL related to it.

To use Split View:
1	 Open an app, for instance Notes.

2	 Swipe up from the bottom of the 
screen to open the Dock.

3	 On the Dock, touch and hold the 
second app that you want to open 
(for instance Safari), then drag it to 
the right or left edge of the screen.

4	 If the app opens in Slide Over (a 
smaller window appearing in your 
app), drag up.

5	 Split View allows apps to fill a 
third or half the screen by playing 
with the central bar

Safari tabs
Using Safari means understanding 
tabs in the app and incognito vs. 
standard tabs.

You can also use Split View in Safari 
to see two web pages side by side

1	 Put your iPad in landscape mode.

2	 Open Safari.

3	 To see two webpages at the same 
time, do one of the following:

Many SIGs provide notes in the SIG Notes area within the SIG Notes folder on 
FirstClass. Access FirstClass from the AUSOM website 

User ID visitorau and password peekdec16. 
Videos from our Main Presentations can be found under the Member Area Tab 

at www.ausom.net.au - access with your personal login and password.

Do you have an idea for a topic you 
would like to see in AUSOM News? 

Send an email to 
editor@ausom.net.au 

 
To book One on One personalised 

training send an email to 
one-one@ausom.net.au
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•	 Open a link in Split View: Touch 
and hold the link, then tap Open in 
Split View.

•	 Open a blank page in Split View: 
Touch and hold , then tap Open 
Split View.

•	 Open a link on the other side of 
Split View: Tap with two fingers on 
the link.

•	 Move a tab to the other side of 
Split View: Drag the tab left or right 
in the Split View.

•	 To leave Split View, touch 
and hold , then tap Merge All 
Tabs. You can also tap to close tabs 
individually and leave Split View.

macOS Intermediate�  
� Function 2
Stephen Withers:  
� osx-intermediate@ausom.net.au

Keep in mind this may have been 
written before the November 
presentation. But made to look like 
after. If you are ready to take that 
serious leap, you have a good long 
break over the Christmas period 
to rectify everything that might go 
wrong. There are no more excuses. 
macOS upgrade here we come. 
At least you will now be primed 
with the best possible advice on 
backup, security, possible favourite 
application fails, recovery paths and 
how to keep getting the best from 
your Mac.

And to make life even easier, this 
month Stephen will present where 
you get help when you’re all alone. 
Firstly as an AUSOM member you 
are never really alone. FirstClass and 
the AUSOM website can put you in 
touch with help pretty quickly. But 
the web is a wonderful thing and 
a huge resource if you just know 
where to look. This month we’ll try 

to demystify the places to look and 
the best search words to help narrow 
down your issues to a simple answer.

We will also do a quick review of last 
year's presentations and seek your 
feedback on what you’d like to hear 
about next year. This has worked 
well the last few years and gives each 
attendant at the OSX SIG a chance 
to find out what you need to get the 
best Mac experience available. Come 
along armed with your greatest OSX 
desires and needs and help us get 
ready for 2018.

And there's a door prize most 
months — sometimes two.

Genealogy	 Function 1
Avril Mitchell and Margaret Rackham: 
genealogy@ausom.net.au

Alan Brown prepared a Web-Card 
Report from Reunion, copied it to a 
read-only CD in html format, so it 
could be read via any web browser. 
It included a searchable index, with 
copies of photos and documents 
— ideal for sending to other family 
members.

Margaret spoke briefly on the wool 
and cotton industries in Yorkshire, 
and a monument in Kirkheaton 
Churchyard to 17 children who 
died tragically in a mill fire almost 

200 years ago. The BBC is likely to 
commemorate that story early next 
year.

In December members will continue 
with the topic of interesting 
occurrences in the places where their 
ancestors lived. Would they have 
been involved or did these affect 
them in any way?

Saturday
1:30pm

Function 1

GarageBand	 Seminar Rm 2
Judy Young: garageband@ausom.net.au

In November members showed some 
examples and ideas for our group 
project. We also discussed music 
composition influences throughput 
the ages.

In December we will continue our 
exciting project-based journey 
through GarageBand on both the 
Mac and the iPad.

 Come along to the GarageBand SIG. 
Learn how easy it is to make a film 
score, a podcast, write a song, and 
MORE.

2:30pm Saturday

Digital Photography	 Function 2
Ngaire Denne, Brad Smith and Bill Oldham:	 
� digital-photography@ausom.net.au
Digital Photography SIG website: https://AUSOM 
digitalphotography2017.wordpress.com/blog/
NOTES: Brad Smith 

November - Last Month
The gremlins seemed to have 
disappeared from the Digital 
Photography SIG and Bill Oldham 
showed us his fine work with a 
very special App for iOS called 
‘Superimpose’. As the name implies, 
the app allows the user to place layers 

Seniors Card now accepted 
10% discount

Sandwiches at a Special Price 
at all AUSOM Meetings

Coffee & Meals also available 
8:30am to 2:30pm Mon-Fri
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and photos on top of each other, 
masking and colouring each in many 
different ways. The app seems almost 
endless in its possibilities so, for 
$2.99 from the iOS App Store, it is 
great value. Look out for Bill’s notes 
elsewhere in this magazine.

December - This Month
We are very lucky to once again 
present Bill Ellemor at our final SIG 
for 2017. (Where did that year go?) If 
your thirst for Photoshop knowledge 
is ‘unquenchable’, then come along 
to December’s presentation and 
see Bill Ellemor ‘messing about in 
the Photoshop toolbox’. He’ll be 
showing us the main editing tools 
and what they’re built to do. It seems 
that Photoshop tools have endless 
possibilities and variations, so it will 
be great to see a pro working the 
tools and creating. Definitely worth 
seeing.

February - Next Meeting
If you haven’t seen it already, Adobe 
have released Photoshop Elements 
2018. (It’s actually Elements 16). It 
doesn’t have a tonne of new features 
but it’s certainly worth buying if 
you don’t need the full version of 
Photoshop. 

We’ll be showing you all the tools in 
the Photoshop Elements 2018 toolbar 
and what they’re used for. 

Thank you for all your support 
during 2017 and we look forward 
to many more informative, fun and 
interesting SIGs in 2018. Merry 
Christmas to you all and a Happy 
and Healthy New Year.

Keep an eye on the SIG timetable 
because our Digital Photography 
SIG may be moving to a MORNING 
spot. Hopefully we’ll have this 
announcement at the December 
meeting.

iPhone	 Events Rm.
Geoff WALLACE: iphone@ausom.net.au

Find out what an iPhone can do.

Come and find out what an iPhone 
can do and learn some of the things 
that you didn’t know it could do.

If you have a suggestion for a Topic, 
send an email to Geoff Wallace with 
your suggestion.

Mobile Multimedia	 Sem. Rm 2 
Peter Emery: ipod–itunes@ausom.net.au

Introducing the Mobile Multimedia 
SIG, replacing the vaguely-named 
iOS Entertainment SIG.

This SIG aims to cover how to use 
various mobile or portable devices 
such as digital photo frames, pre-iOS 
iPods, iOS iPods, iPads & iPhones; 
Android or Windows Phones in a 
Mac environment.

We’ll explore how to share 
multimedia, be it movies, music, 
photos, documents between Mac 
computers and mobile devices. The 
Mac can be used successfully to 
co-ordinate multimedia on these 
very assorted devices, in ways both 
awkward and easy.

Bring along your questions, 
suggestions and solutions to share 
with other users. It’s going to be 
informative and entertaining as we 
explore the wonderful interconnected 
world of Mobile Multimedia.

Newcomers & Greenhorns�  
� Function 1
Stephen Withers: nags@ausom.net.au

Members are encouraged to discuss/
ask questions about any computer-
related subject at a beginners level. 
While our aim is to clarify and 
expand on themes, we also keep the 
discussion as uncomplicated and 
non-technical as possible.

Many issues raised within this group 
are resolved immediately, either 
by other members, by searching 
MacHelp on our computers or by 
using the Internet. Many solutions 
are quickly and easily found via the 
Internet and we spend some time 
each session exploring how to best 
take advantage of this resource. 
More difficult or technical issues are 
usually directed to advanced SIGs or 
'gurus' in the club.

10am Wed. 13th December

Retirees & Others� Balwyn
Judy Young: retirees-others@ausom.net.au

December — both sessions
Pat Tasker's Animation Group will 
entertain us with an animated story: 
'Cyril the Snake'.

November
Geoff Wallace — both sessions

Geoff unravelled the myths and 
mysteries of MacOS High Sierra

He discussed new features, suitable 
hardware requirements, and gave 
downloading advice.

He also answered questions on a 
range of surrounding topics.

6:30 pm Thurs 14th December

AUSOM� Mornington
Ron Kempster: amg@ausom.net.au

Once again we were treated to 2 
excellent presentations. 

The first was from Neil Shelley who 
expertly explained & demonstrated 
how to use Mission Control.  I am 
sure we all agreed it is definitely an 
application to be explored further.

Our second presentation was a 
joint effort from Peter Emery and 
Rob Fincher.  Between them they 
took us through the changes in Hi 
Sierra on a Mac and the iOS update 
changes on an iPad.  Although the 
technical details left some of us 
cross-eyed, Peter alerted us to the 
important points to be aware of 
before attempting an upgrade.   Rob 
then demonstrated some of the new 
& exciting tricks we can use on an 
iPad, many of which could be easily 
missed.

We all came away having learned a 
lot from both presentations & I can’t 
wait to try some of them out.

December Meeting

NOTE: The December Meeting 
is on Thursday 14th December. 

That is the second Thursday.

See display ad on page 11.
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Retirees & Others
Wednesday 13th December 2017

10.00am - 12.00noon

come along and join the fun

Pat Tasker’s Animation Group 
will entertain us with an animated story:

Cyril the Snake

 20 minute tea break 
 between sessions

Second Wednesday of each month except January.  
10:00am–12:00noon. 
Baptist Church Hall cr Whitehorse & Parring Rds, Balwyn  
Melway 46 F8. Tram stop 50 
Email: retirees-others@ausom.net.au

No Meeting in December for Everything Apple. 
Our next meeting is Tuesday 20th February 2018

Everything Apple� MelbPC
Julie Ackland & Peter Emery: everything-apple@ausom.net.au

The group discussed Watch v 3, iPhone 8 and X.

High Sierra — the new operating system for your Mac; 
brings better Photo editing to your Mac but ensure your 
screen resolution is such that you can view the drop-
down menus.

PresButan
Pete recommended ‘program your keyboard’ app that 
programs buttons — delete etc. Download from the web 
here. http://briankendall.net/presButan/

For apps that need to work within your firewall or make 
changes in your Mac privacy settings (such as PresButan 
above) remember you can Drag and drop apps from your 
Mac applications folder into privacy and security.

iTunes — App Store library gone?
If you are disappointed that you can no longer copy apps 
from one device to another in iTunes 12.7 then download 
Enterprise iTunes 12.6.3 — generally easy to find at Apple 
downloads page returns the apps store to your iTunes for 
downloading apps.

A Mac Tip
For apps that need to work within your firewall or make 
changes in your Mac privacy settings remember you can 
Drag and drop apps from your Mac applications folder 
into privacy and security.

MAKE A PDF. Portable Document File iOS 11

• Make a pdf from a document, spreadsheet or mail

• Select print, pinch out to full screen, save to pdf in files 
(if you have ios11)

• Notes of course has a direct activity link to save as a pdf

• Photos can be saved as pdfs into iBooks

Ever wondered what the Rolling Shutter effect is and how 
to use it to best effect — Rolling shutter explained — see 
this Smarter Every Day video. https://www.youtube.com/
watch?v=dNVtMmLlnoE&t=204s.

NOTE: No Meeting in Dec. or Jan.
Next Meeting: Tuesday 20th February

⌘

Pam Doughty

At iWork SIG Nov. 2017...
I had an image of a Christmas tree and when I entered 
Christmas in the search field in the Photos app on the 
Mac few were surprised when the image was selected. 

To establish how 'clever' Photos can be I downloaded a 
clip art Christmas tree image. After adding it to Photos 
the search then located my new image plus the original 
photo. I understand that Photos now scans your images 
and can detect over 4,000 different objects and seven 
different facial expressions.

It also adds categories to images automatically, using 
metadata from the photos and tags.

So you can search for things like "birthday cake" or 
waterfall" and Photos will be able to return the results.

⌘
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AUSOM Advertisement further details www.ausom.net.au/events/

 

Apple Users Society of 
Melbourne 
(AUSOM) 

Mornington Peninsula Group 
 

Next Meeting – 
14th December 2017 

 

  

 
6.15: Sign in for a 6.30 pm start 
 
6.30 – 7.30 

 

MEMBERS DEMONSTRATE      
their favourite apps and 

useful tips. 
 

7.30 – 8.30   
Refreshments,  

end of year breakup & informal 
networking 

 
 
 

$10.00 non member visitor fee applies 
after first visit unless joining. 

 

 
 

 

VENUE: 
Mornington Community Information Centre 

320 Main Street, (cnr Elizabeth St) Mornington. 
(Melways Map 104 E12/F12) 

Enter via car park at rear of building. 
 

Email:  amg@ausom.net.au 

Main Presentation
Events Room 11 AM - 11:50 AM

Movie Makers 
present a selection of 
films made by the 

SIG Members.

1. Ethics of Fashion - Tim Gurrie 

2. Panama Canal - Roy Heeps 

3. TruView Montage - SIG Members 

4. Artesian Basin - Geoff Teller 

5. A Christmas Retrospective - Roger Threlfall 

6. Christmas in the City - Chris McQuillen 

7. Walls - Norm Tillack

December 2, 2017

Major Raffle

Tickets just $5 at the Raffle Desk or purchase at 
www.ausom.net.au/raffle

3rd Prize in AUSOM's Major 
Raffle could be yours!

Help Wanted

Members willing to give-back a little time 
to help others. Whatever your interests 
and expertise AUSOM needs you! 
YOU might… 
• Attend SIGs and ask questions so others 

learn with you — offer to write up SIG 
notes for AUSOM News 

• Attend the next few Committee meetings. 
It would be great if you join as a member 
to make up the 8 people we need. 
However, one or two extra helpers 
attending meetings would be very 
welcome. 

You will Help 
build AUSOM
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Julie Ackland 

App Tap�

The Shelf — works best on iPad, iPhone; free

The Shelf is a kind of slide-out desktop for the iPad. 
When you use it in split view or slide-over, you can drag 
and drop many files and objects straight into its window. 
At launch, it will work with the following data types.

•• Locations from the Maps app
•• Emails from Mail app
•• Images
•• URLs (with rich previews)
•• App links
•• Attributed text
•• Plain text

You just drag files into The Shelf, and leave them there 
until you need them. You can also copy items to the 
clipboard, switch to The Shelf, and tap Paste to paste them 
into the app — useful if you’re using the iPad with an 
external keyboard.

Acronis Mobile — App is free for iPhone, iPad — $69.99 
1 year subscription for Mac and PC including storage of 
250Gb

Acronis have just released a new backup for desk and 
laptop computers. But with it comes a free app to backup 
your phone or tablet. Their motto is “Around the corner 
or around the world – you’re covered”.

Safeguard all of the photos, videos, contacts, reminders, 
and calendar appointments on your smartphone or tablet 
to ensure you never lose them – even if your device is lost 
or stolen.

Cover all of your family’s smartphones and tablets with 
one account. You can protect their data and remotely 
manage the backup plan for each device using a single 
dashboard.

Create backups of your mobile device automatically 
and wirelessly over Wi-Fi to your PC, Mac and, new in 
Acronis True Image 2018, NAS device. Backup by simply 
coming home.

Retrieve just the specific file you need without having to 
perform a complete recovery of your device’s content.

Schedule times, configure destinations, and select from 
full image, incremental, differential or custom backup 
types.

Browse the contents of your mobile backups on the local 
PC or Mac on which you store the backup files.

Lr CC (Lightroom by Adobe). Free

Adobe Photoshop Lightroom — if Apple have not given 
you enough photo-editing power in High Sierra and IOS 
11 then this might be the app you need.

You should have an Adobe account — either free to 
sign up or you can log in with your Facebook or Google 
accounts (see IPad Coach this month)

⌘
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Judy Young

Notes from November Main Presentation�

We were very fortunate to have veteran journalist Garry 
Barker alias MacMan as our presenter in November.

Garry took us on his journalism journey from D-grade 
reporter, to serving in Asia as a bureau chief, writing his 
popular MacMan column, then re-inventing himself as 
podcaster to produce ‘Talking Business’ for RMIT. And 
traveling regularly to Cupertino to keep us informed of 
the latest developments at Apple.

See his article ‘A misspent youth continuing (so far)’ 
— p10 AUSOM News November 2017, which covers 
highlights from his early life in NZ to the current day.

Garry talked about his relationship with Apple and their 
products, and offered insights into our automated future.

Apple
As MacMan Garry travelled extensively, meeting with 
Steve Jobs on several occasions and with the current 
Apple CEO Tim Cooke.

Steve Jobs introduced Apple technology to people in a 
language people understood. He understood the need for 
a computer that everyday people could use.

Technology has changed the world. Most notable 
examples include: The Apple iPhone, released 2007, 
which changed the way we interact. Garry gave an 
example of a dinner he attended where people were 
absorbed with their iPhones at the table instead of 
interacting with each other in person.

The Apple Watch — another extraordinary 
innovation.
Barker says, the Apple Watch and the healthcare apps 
on it, and the iPhone probably saved his life or, at least, 
saved him from partial paralysis from a stroke. Fast 
identification of his extremely variable heart rate lead to 
immediate hospitalisation and a safe return to health.

Future directions for Apple will be more about services 
than hardware. Apple is involved with the development 
of medical and educational software reflecting Steve Jobs’ 
aim to make the world a better place.

Automation — implications and issues
Machines are faster, accurate and more efficient, however 
autonomous transport, automated production, and other 
workplace technology will cause loss of jobs. This will 
lead to disruption of the financial structure of our society. 
A substantial decrease in mandatory superannuation 
and taxable income will result in decreased government 
revenue that supports the unemployed and our general 
standard of living. How then can enough money be 

raised? Garry suggested that we need to tax the robots. 
Also, we should aim to create work that Machines cannot 
do, such as jobs requiring personal interaction for 
example childcare and aged care.

He also pointed out that we need to pay attention to basic 
literacy skills.

Questions
Garry gave comprehensive answers to questions relating 
to medical and educational software, data privacy, 
unemployment and government revenue concerns. 
This information is included in the body of the text to 
maintain continuity.

Garry’s presentation was accompanied by a photographic 
history of Apple hardware including Bondi Blue iMac 
-1998, iPhone — 2007 and the Apple Watch Series 1- 2015

Ivan Radywonik kindly prepared the Apple product 
keynote from photos and captions provided by Garry

Conclusion
Technology has a huge impact on the way we live our 
lives.

There are emerging economic, political and social 
concerns. We must embrace the changes, challenges and 
chances presented by our automated future.

Thank you, Garry for your very interesting and thought-
provoking presentation.

⌘
Pam Doughty

At Mornington Group...
A member at the Mornington meeting was delighted 
with the latest ability to save images and sound from 
a FaceTime conversation with her grandchild. This is 
something others might be very keen to try especially over 
the holiday season.

The member said it was very easy — she just had to press 
the button and the photo saved had no distracting buttons 
or tiny image in the top right-hand corner. It also had 
audio.

Provided everyone is using iOS11 others might also find 
this new feature valuable.

If you do NOT want to be 'recorded' just turn off 
FaceTime Live Photos option in Settings >FaceTime.

⌘
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Bill Oldham: digital-photography@ausom.net.au

The Rabbit Burrow�
Using the Superimpose app
Introduction
The world of apps for the iPhone/iPad is pretty new to 
me. Just about the time that I figure out how to use one, 
there is an update that seems to make me start over again 
with familiar icons but now in different places on the 
screen. And I still have to learn the new features as well.

Matters are further complicated by my reluctance to 
spend money on apps. After the editor showed me 
how many apps that you can get free that do just about 
everything you want, it was hard to open my wallet and 
let the moths fly out.

But one of the online courses, about using your iPhone as 
a camera, convinced me to buy the Superimpose app for 
$2.99. And it was worth it!

Over the next few months (years?), I am also going to be 
looking at some other apps that mean spending a bit more 
money and a lot more time. These include Snapseed, 
Distressed FX, Element FX, Photoshake, Glaze, ArtRage, 
Decim8, Image Blender, MonoVu, Lenka, Camera+, and 
Icolorama (a killer app with a steep learning curve).

Follow along with these notes at home or in the SIG. But 
if you want to follow along with this article, you will need 
to download the Superimpose app from the Apple Store.

Why would I want to use Superimpose?
Let me quote this paragraph from the Mac Sources App 
Review:

“Superimpose app allows you to make superimposed 
(One image laid over the other image — Bill) or 
juxtaposed photos (Both images set side by side — Bill) 
right on your iPhone. You can transform, blend, mix, 
combine, add filters, create masks, adjust exposure, add 
text (I don’t think so — Bill), blur and much more. You 
can use brush, lasso, polygon, global colour similarity, 
rectangle, ellipse, linear, bi-linear, radial gradient and so 
on. The possibilities are vast, and you choose which of the 
app features to use — from light photo editing to really 
professional image creation. For creative souls the app 
brings an opportunity to spend hours in it and to create 
complex superimposed or juxtaposed photos. You will 
never get bored with this app.” 
Source: https://macsources.com/superimpose-ios-app-review/

What will I learn from these notes on Superimpose?
•• create double exposure composites using blend modes
•• create an artistic effect by layering together a colour 

and a black and white copy of the same image
•• layer the same image multiple times for unique effects
•• use a texture as an overlay
•• change the background of an image by using a mask
•• how to add a person to a landscape
•• how to alter the foreground image.

Further information on these methods can be found at:

(1) https://iphonephotographyschool.com/add-
backgrounds/

(2) https://iphonephotographyschool.com/add-textures/

(3) https://iphonephotographyschool.com/superimpose-
layers/

(4) https://iphonephotographyschool.com/double-
exposure-portraits/

Just a note about the website. It contains all sorts of good 
free information about using your iPhone as a camera. 
However, the pop up ads seem to defeat my ad blocker 
and really give me the irrits!

It’s going to be a busy day at the SIG trying to demonstrate 
seven things to do in only fifty minutes. So let’s begin with 
double exposures and see how far we get.

Where and how do I get started?
First you need to download and install Superimpose on 
your iPhone/iPad. This assumes that you have an iTunes 
account and some credit to be able to lash out for the $3 
that you need to spend to purchase Superimpose. If you 
are not sure about this, arrange a one-to-one help session 
for the next AUSOM monthly meeting.

Method 1 — How to create a double exposure using 
Superimpose

First here is a good image to get you interested.

Source: https://iphonephotographyschool.com/brandon-
kidwell/
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Now that you are hopefully all keen and champing at the 
bit, you need to find two images on your camera roll. 

The main guideline: pick two images that look good.

It has taken me a long time to realise that I cannot wave 
my Magical Bill’s wand and turn a crummy photo into 
something beautiful. The image has to be good to start 
with.

The image that I am using here was chosen because 
it has only one focal point and a lot of negative space 
surrounding it. Well, it actually started as a flower against 
a sky background and then got dumped for a selfie.

I have had an interesting month (remember the Chinese 
curse? “May you have an interesting year!”) learning 
how to move images around my different devices. From 
Desktop to laptop is OK. But laptop to iPhone/iPad 
has not been quite as easy. But with a lot of help from 
FirstClass, the problems were gradually resolved. Aside 
from Mulgrave Brad’s short reply of ROFL. What ever that 
means.

These notes are abridged since they were already 
published in the November AUSOM News. So if you can't 
remember how to do something, go back and look it up in 
AUSOM News.

(1) Open Superimpose.

(2) Select your background image.

(3) Tap on choose. My background image is this one.

(4) Pick a texture to use as the foreground.

(5) Tap on Choose. The image after Point (7) is my 
foreground image of a texture on top of the background 
photo.

(6) Tap on the Transform icon at the bottom of the screen.

(7) Move the corners by tapping and dragging on the 
corners of the texture till they cover the background 
image. Or just double tap on the top layer and it fills up 
the background.

(8) Experiment with the Blend Modes and Opacity Slider 
to get something that you are happy with. Here is what I 
finished up with.
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That’s it for Method 1 of Double Exposures. I have a 
long way to go to get any thing that looks like the one at 
the beginning. If you want more information, try here: 
https://iphonephotographyschool.com/brandon-kidwell/

Method 2 — create an artistic effect by layering together a 
colour and a black and white copy of the same image

By this time you should be getting around in Superimpose 
a bit better. So I’ll shorten the instructions.

(1) Open the same image in both background (the black 
and white image) and foreground (the colour image).

(2) Tap on the Transform icon.

(3) Tap on the crossed arrows in the upper right hand 
corner. This expands the foreground image to cover the 
background image. If you notice that the layers are not 
correctly aligned go back and try again!

(4) Tap on the filters icon.

(5) Tap on the gear wheels in the upper right hand 
corner. This brings up a dialogue box that lets you edit 
the foreground and background images separately with 
the following tools — brightness/contrast, colours, hue/
saturation, thirty three effects, blur, and a very basic 
curves tool.

Have a play with them. My best efforts seem to be to 
create some abstract art as shown in the figure below.

Method 3 — Using multiple images and layers to create 
an artistic master piece.

Once again, here is an image to whet your appetite to 
show you the effects of using multiple layers.

Source — https://iphonephotographyschool.com/
superimpose-layers/

This technique is really beginning to unleash your 
imagination.

(1) Open up two images as the background and 
foreground images in Superimpose.

(2) Do your thing (transform, blend, filters, even masking 
if you are game enough!).

(3) Tap on the Transform icon.

(4) Tap on the Merge icon at the top third from the left 
(looks like a downward arrow over two bed sheets). This 
will merge the two layers into one.

(5) Tap on the Home icon.

(6) Tap on the icon second from the left at the top (looks 
like a box with an arrow escaping to the right.

You get a Dialogue box that looks like this:
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You get a few choices here. I have no idea what the first 
row does for saving Metadata. In fact, I have even less 
clues of what Metadata actually does aside from putting a 
copyright on my own photos.

Next row down is for how much quality that you want to 
keep. Set it to about a 35 for email and monitor images. 
Choose 100 for quality photos that you want to print.

The next row down is for what you want to do with 
your image. You can save it to photos, share it (another 
fourteen choices), and one that I use a lot — Mask as 
PNG. There is also a choice for a drop shadow that you 
can use. See Brad for details about how to add drop 
shadows and flaming texts effects.

(7) What you have now is a merged background and 
nothing in the foreground. So pick another image for 
your foreground and repeat the process all over as many 
times as you like.

(8) If you are interested, send me a copy of your artistic 
creation in jpg format to publish in AUSOM News.

Method 4 — using the same image multiple times.

This is a variation of Method 3. The difference is that the 
same photo has been used several times in different sizes 
and different locations.

Source — https://iphonephotographyschool.com/
superimpose-layers/

For more help with this method, go to the website 
here and go to the end of the article at: https://
iphonephotographyschool.com/superimpose-layers/.

Now we move on to another three ways that you can use 
textures to improve your photos.

Why use textures?
Here are three possible ways that you might use textures. 
One is to use a texture to overlay a photo and then see 
what happens with the different blend modes. Another 
way is to use a texture to replace the background of an 
image so that the main subject stands out more than 

before. And a third way is to alter the foreground image, 
which we might leave for the February News.

Method 5 — Use a texture to enhance your photo

More information from: https://
iphHonephotographyschool.com/add-textures

Here is an example of the first way to use a texture with 
blend modes.

(1) Open Superimpose.

(2) Select your background image.

(3) Tap on choose. My background image is this one.

Source: Photoshop Artistry Resources — https://www.
picturecorrect.com/tips/Photoshop-artistry-course

(4) Pick a texture to use as the foreground.

(5) Tap on choose. Here is my foreground image of a 
texture on top of the background photo.

Source: https://www.freepik.com/free-photos-vectors/ice
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(6) Tap on the Transform icon at the bottom of the screen.

(7) Move the corners by tapping and dragging on the 
corners of the texture till they cover the background 
image. Or just double tap on the top layer and it fills up 
the background.

(8) Experiment with the Blend Modes and Opacity Slider 
to get something that you are happy with. Here is what I 
finished up with.

So, that is one way that you can use textures with one 
of your photos. Here is a second way — you can use a 
texture to replace a distracting background.

Method 6 — Changing the background by using a mask.

Masking a layer can vary from being dead easy to 
fairly complex. For this example, we will look at the 
easy way. But instead of the texture being the top layer 
(foreground), it will be the bottom layer (background).

What we are trying to do here is to avoid changing the 
colour of the flower as would happen if we tried to use 
blend modes.

(1) Open Superimpose.

(2) Select your background image.

(3) Tap on choose. My background image is this one.

Source — https://iphonephotographyschool.com/add-
textures/

(4) Pick a flower to use as the foreground.

(5) Tap on choose. Here is what mine looks like.

Source — https://iphonephotographyschool.com/add-
textures/

(6) Tap on the Transform icon at the bottom of the screen.

(7) Move the corners by tapping and dragging on the 
corners of the texture till they cover the background 
image.

(8) Tap on the Mask icon at the bottom of the screen.

(9) Tap on the Magic Wand Tool.

Conclusion
We have had a look at some of the ways that you can use 
Superimpose to enhance your photos.

I hope that this article will encourage you to try some new 
ideas with your iPad or iPhone for editing your images to 
go from a good start to a work of art.

⌘

Contents

http://www.ausom.net.au
https://iphonephotographyschool.com/add-textures/
https://iphonephotographyschool.com/add-textures/
https://iphonephotographyschool.com/add-textures/
https://iphonephotographyschool.com/add-textures/


www.ausom.net.au AUSOM News December 2017 v 19

Apple Mac® assistance 
and/or training at your own 
location anywhere on the 
Mornington Peninsula 
(Mordialloc to Portsea)
Hourly rate $75.00

Call Patrick Bravard

0419 330 497

patthemac@me.com

M

EPat the Mac

Ivan Radywonik

Cozzak's Tip #121�

A reminder that other web browsers exist besides 
Safari and that having them available is a suitable 
workaround to many web browsing issues — try 
Chrome, Firefox or Opera as useful alternatives. 

The Tip of the Month originated with the AUSOM 
Podcast and although it is no longer produced, you can 
still subscribe to the podcast to download and listen 
to past episodes (68, in all). It’s free, and a convenient 
way to explore the rich and diverse constitution of our 
membership; just go to

www.ausom.net.au/podcasts or subscribe via iTunes.

⌘

macfixer
Mac Training . Tuition . Troubleshooting

At your premises, at a time to suit you

Call 03   9 893 1677
Call 0412 056 033

• Perform Software Updates, Backups, Memory Upgrades
• Teach use of Mac Operating System and Software such as iTunes, Calendar, 

Contacts, Pages and more, advice on Hardware Upgrade and Purchase
• Set up Modem, Wireless Internet (WiFi), Shared Printer, Email Account, 

Transfer data from Mac to Mac and PC to Mac
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www.macfixer.com.au
Geoff Wallace

geoffw@macfixer.com.au
Pam Doughty

Mail Quick Tip

I selected and recoloured 
some of the stars before 
sending the modified photo.

NOTE the message size has 
increased a little.

⌘

I was about to send a photo 
using Mail on my Mac when I 
realised the tree had not been 
decorated.

I selected Markup (top right 
of the image) and added a star 
with yellow fill and yellow 
outline.

The process took a little while 
so I was not looking forward 
to adding too many stars.

Then I found that to duplicate 
a selected star I could hold 
down the option key and drag 
the star.
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Keith Bishop

Photo Ops available for December�
Available over the next two 
months

If you are reading the 
printed version of our 
magazine, you need to view 
the pdf version in order to 
see these photos in all their 
colour glory.

Christmas lights
Jump in the car and go for 
a cruise around the streets. 
Don’t forget your camera 
and tripod. It is amazing the 
effects that Melbournians 
go to celebrate Christmas 
by illuminating their 
properties. 

See AUSOM News 
December 2015 and 2016 
for an example of the 
discoveries that I have made. 

Myer Christmas windows
A Melbourne Christmas 
tradition for 62 years. A 
challenging photo op, as 
you photograph through 
the glass windows that have 
smudges from little hands 
and reflect the lights of 
Bourke Street. An additional 
challenge is movement 
within the widow displays.

Last year the theme was 
One Christmas Eve, which 
tells the experiences of Bella 
when Grandpa showed her 
a Christmas Eve not to be 
forgotten. Having eaten 
their evening meal, Grandpa 
topped up the paddle pool 
with the garden hose, while 
the little brother swings on 
the Hills Hoist 

Grandpa takes Bella to 
Luna Park 

The sparkling carousel 
was the most beautiful 
item 

and Bella with a coin in 
her hand approached the 
ticket box 

As Bella rode her majestic 
horse she sped round 
faster and faster. Over 
Luna Park 

onto the sea of candles as 
the music drifted up to 
the stars 

Bella thanks her new 
found friend 

and on Christmas 
morning Bella found her 
Christmas present 

At AUSOM News 
deadline, this year’s 
theme has not been 
revealed.

Christmas in Melbourne
The CBD of Melbourne 
has many photo ops 
throughout the whole 
city. Here are some of 
the photos my daughter 
Debbie and I took last 
Christmas. Our first stop 
was the Crown Atrium. 
The stairway was lined 
with baubles for different 
Christmas carols 

The jingle Bells bauble 

We wish you a merry 
Christmas 

As we left, we passed the 
Christmas in the hotel foyer 
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Have you seen Princes 
Bridge like this? 

We wandered on and found 
The Christmas Tree at 
Melbourne Central Station  

The Christmas Tree at the 
new Emporium Melbourne

The Bourke Street Mall 
lights over the tram tracks 

The banners in the mall 

The light projections on 
the town hall 

The Christmas Tree at the 
City Square 

The nativity scene also at 
the City Square 

Our final visit was 
Federation Square where 
we found the giant bauble 

and the lighted tree  

At the time of writing 
this, details of this year’s 
decorations have not been 
disclosed. However, the City 
Square will not feature as it 
is closed due to the Metro 
Tunnel project.

Melbourne to Hobart 
(Westcoaster) yacht race. 
The race is preceded by 
the Cock of the Bay aka 
the Boxing Day Dash from 
near Station Pier in Port 
Melbourne at 10:30AM 
sailing past St Kilda Pier, 
Royal Brighton Yacht Club 
and Sandringham Yacht 
Club. Staying overnight at 
Blairgowrie Yacht Club on 
December 27 they sail from 
Portsea at 11:30AM. You 
could photograph them 
from Point Lonsdale as they 
race for the heads of Port 
Phillip Bay.

Ray Chatterton advises that 
The Tooradin Tractor Pull 
& Truck Show is a fabulous 
family day packed with lots 
of fun things to see and 
do. It is on January 18 at 
Rutter Reserve Tooradin. An 
opportunity to photograph 
the tractors at work and 
the trucks on display. www.
tooradintractorpull.com.au/

Festival of Sails Geelong 
Australia Day weekend

The Southern Hemisphere’s 
largest annual keel boat 
regatta in Corio Bay  
festivalofsails.com.au

Australia Day Parade 
January 26, 2018 11AM - 
12noon Swanston Street 
Melbourne

Celebrating the rich history, 
diverse society and the 
unique heritage of Australia.

Phillip Island Model 
Railway Exhibition
The Phillip Island & 
District Railway Modellers 
Annual Exhibition at the 
Cowes Cultural Centre, 91 
Thompson Avenue, Cowes. 
January 13 and 14 from 
10AM.

Entry: Adults $7.00. 
Concession/Child $5.00 
Family $20.00 - max 2 
Adults & 3 Children

National Clydesdale and 
Heavy Horse Festival 
January 20, 21, 2017 
Werribee Park National 
Equestrian Centre, 170 K 
Road, Werribee South. See 
the giants of the horse world 
including Clydesdale, Shire, 
Percheron, Fjord, Highland 
Pony, Friesian, Gypsy Cob, 
Drum Horse and Halflinger.

For a detailed photographic 
report see AUSOM News 
October 2016

Australian Chainsaw 
Carving Championship 
2018 presented by SkyHigh 
at Mount Dandenong 
January 16 - 21 

Don’t be misled by the 
use of chainsaws, the 
sculptors wield them like a 
conductor’s baton, turning 
plain logs into amazing 
works of art. Last year, 
there were 10 sculptors 
participating. Five from 
Australia, two from the USA 
and one each from Canada, 
Japan and the Czech 
Republic. 

Here is a few photos from 
last year’s competition.

Sizing up the job 

that’s the aim 
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Susan Jensen

Third Prize: AUSOM 
Major Raffle�

We are coming to the close of our annual Major Raffle. 
Prizes will be drawn on December 2nd at our NewHope 
meeting. Apple has recently released this new model of 
Apple TV featuring the ability to show 4K HDR videos.

Let’s have a look at our third prize, just to whet your 
appetite and enthusiasm.

Apple TV 4K lets you watch movies and shows 
in amazing 4K HDR quality. Play visually rich, 
interactive games and enjoy great content from 
iTunes and apps like Netflix. (Paid separately).

Capacity
AUSOM has chosen the 64GB model featuring:

•• Siri Remote, with Menu and dual microphone for Siri
•• Bluetooth 4.0 wireless technology
•• IR transmitter
•• Accelerometer and three-axis gyro
•• Lightning connector for charging
•• Rechargeable battery providing months of battery life 

on a single charge (with typical daily usage)
•• Charging via USB to computer system or power 

adapter (sold separately).

Ports and Interfaces
•• Built-in power supply
•• HDMI
•• Gigabit Ethernet
•• HDMI 2.0a
•• 802.11ac Wi-Fi with MIMO; simultaneous dual band 

(2.4GHz and 5GHz)
•• Gigabit Ethernet
•• Bluetooth 5.0 wireless technology
•• IR receiver
•• Built-in power supply

Processor
A10X Fusion chip with 64-bit architecture

System Requirements
iTunes purchasing, renting and Home Sharing require an 
iTunes Store account.

Requires 802.11 wireless, an Ethernet network or 
broadband Internet access.

Requires 4K and HDR TV for 4K and HDR streaming.

Requires acceptance of the software licence terms at 
www.apple.com/legal/sla.
Requires an HDMI cable (sold separately).

a kookaburra 

Let’s get started 

This carver has a more 
ambitious plan 

Cutting a slot 

to fit another opera house 
sail 

It’s taking shape 

Another carver hard at work 

Already carved at the top of 
his log 

Other work in progress 
includes a truck 

and the man from Snowy 
River 

Continued Page 42 
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Video Formats
H.264/HEVC SDR video up to 2160p, 
60 fps, Main/Main 10 Profile.

HEVC Dolby Vision (Profile 5)/
HDR10 (Main 10 Profile) up to 2160p.

H.264 Baseline Profile level 3.0 or 
lower with AAC-LC audio up to 160 
Kbps per channel, 48kHz, stereo 
audio in .m4v, .mp4 and .mov file 
formats.

MPEG-4 video up to 2.5 Mbps, 640 
by 480 pixels, 30 fps, Simple Profile 
with AAC-LC audio up to 160 Kbps, 
48kHz, stereo audio in .m4v, .mp4 
and .mov file formats.

Audio Formats
HE-AAC (V1), AAC (up to 320 
Kbps), protected AAC (from iTunes 
Store), MP3 (up to 320 Kbps), MP3 
VBR, Apple Lossless, FLAC, AIFF 
and WAV; AC-3 (Dolby Digital 5.1) 
and E-AC-3 (Dolby Digital Plus 7.1 
surround sound).

Photo Formats
HEIF, JPEG, GIF, TIFF

Compatibility
Apple TV is compatible with HD and 
UHD TVs with HDMI.

Apple TV is compatible with 
Bluetooth keyboards.

Accessibility
Accessibility features help people with 
disabilities get the most out of their 
Apple TV. With built-in support for 
vision, hearing, physical and motor 
skills, and learning and literacy, 
you can easily find and enjoy your 
favourite entertainment.

Features include:
•• VoiceOver
•• Zoom
•• Increase Contrast
•• Reduce Motion
•• Closed Caption and SDH Support
•• Audio Descriptions
•• Siri and Dictation
•• Switch Control.

In the Box
Apple TV 4K
Siri Remote

Power cord
Lightning to USB Cable
Documentation.

Apple TV and the 
Environment
Apple takes a complete product life 
cycle approach to determining our 
environmental impact.

Apple TV 4K and the Siri Remote are 
designed with the following features 
to reduce their environmental 
impact: 
•• Apple TV 4K
•• BFR-free
•• PVC-free
•• Meets ENERGY STAR 5.0 

requirements.

Siri Remote
•• Arsenic-free glass
•• BFR-free
•• PVC-free
•• Recyclable aluminium enclosure.

⌘

Closing 2nd December
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Pam Doughty

Summarize service on MacOS�

To use Summarize select the text you want to summarize, 
and then invoke the service. This can be found when 
you select Services under an App’s Menu item or by 
right-clicking (control-clicking) your mouse or trackpad. 
Example: within TextEdit select the text then choose 
TextEdit>Services>Summarize, or right-click the selected 
text and click Service>Summarize.

Original article

A new window appears showing the selected text and the 
slider below. Moving the slider reduces or increases the 
amount of text within the summary. Using the sentences 
setting nearly always gives better results.

Less text

More text

If you cannot see the Summarize service you may need 
to open System Preferences, and the Keyboard section. 
Select Shortcuts in the toolbar, then click Services in the 
list on the left. Scroll down until you find Summarize in 
the list. Check the box to activate it, and it will appear in 
the Services menu.

Why might you use this?
If you have a very large document to read, reducing the 
content will save you time. You will need to decide if it is 
worth missing out on the remainder.

If you have written an article, it may be worth running 
summarize and reading the summary. If the summary has 
left out the main points you wanted to make, try altering 
the original to ensure your message really shines.

⌘
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Dick Johnson

iPad Magic – 75�

iOS 11
Yes. It’s that time of the year again and Apple has come 
forward with its annual update of the operating system 
for the iPhone and the iPad. However on this occasion 
the real action is under the hood where a very significant 
change has taken place, something akin to taking the 
petrol-driven motor out of the car and replacing it with a 
Tesla battery.

I also must point out that I am using an iPhone6+ and 
an iPad2, the latter now getting a bit long in the tooth. 
As a consequence there are things you can do with a 
modern iPad that I will not be able to report on and 
the functionality of my iPhone does not allow haptic 
responses (where the phone vibrates in response to the 
pressure you apply). So until I change over my own units, 
this will be my last article on iOS upgrades.

Under the Hood

64 Bit Processing
The big news of iOS11 is that Apple has moved from 
32-bit addressing to 64-bit. To understand this better, let’s 
go back to the industry at its start, back to the 70s and 
early 80s, when 8-bit processing was the new big thing. 
Each bit, the “atom”, or smallest unit of information in 
computing, can have a value of either 1 or 0, and these 
bits are organised into blocks of 8 called bytes, starting 
at 00000000 and ranging through all the possibilities 
up to 11111111. This was the source of the ASCII range 
of 128 characters. Every character had its own bit code: 
A was 65, B was 66, all the way through to Z, which 
was 90. In turn the lower case characters had their own 
representations, where a was 97, b was 98 through to z, 
which was 122. With 128 possibilities in the range there 
were a lot of spaces for the ten digits (0123456789), 
special characters such as @,?,&,% together with a 
number of non-printing characters that could be used to 
trigger actions within the computer. I still have the 128 
ASCII character list stuck on my desk as a reference, and 
it’s been there for well over thirty years now. 

Each element within the computer’s memory has a value 
and an address. You have to know how to look it up and 
then look to see what its value is. In the early days of 
personal computing, values could be represented by a 
single byte, but it was necessary to combine two bytes 
together to express an address. One byte alone simply 
didn’t provide sufficient addresses for meaningful 
computation. So an uneasy compromise developed where 
addresses required two bytes (16 bits) but the value of 
the element contained only required one byte (8 bits) to 
express its value. 

As the semiconductor revolution pushed on it became 
possible to formalise the movement to 16-bit addressing 
and value representation. Everyone knew that this was 
only a stop-gap until further technological innovation 
made it possible to go to 32-bit processing, where very 
large numbers of addresses (232) and very complicated 
numbers could be represented and manipulated. Despite 
this, the move was on to go to the next step, 64-bit 
addressing and value representation, where the options 
(264) for both addresses and values represented are 
utterly huge.

You will remember the question of the king to the humble 
mathematician who had performed a great service for 
his master. What do you want? Name anything in the 
kingdom. The mathematician replied: Sire, I ask only that 
on the first square of a chessboard you give me one grain 
of wheat, on the second square two grains, on the third, 
four grains, doubling at each square until all squares 
of the chessboard are covered. The king laughed at the 
trifling request, not realising then that the final number is 
so huge that it would be almost impossible to supply. 

The beauty of the upgrade is that we do not have to 
worry about any of this once we have changed over our 
iPhones and iPads, in the same way that we don’t have 
to understand how our car engine, synchronous gearbox 
or differential work when we get in our car to drive 
somewhere. It all just happens. 

Apps that will no longer Work
But there are some traps. The apps on our devices must 
be written for 64-bit addressing in order to work once 
you’ve upgraded to iOS11. An awful lot aren’t. Where 
app developers have lost interest in their children and 
failed to upgrade them, then they will no longer work 
and Apple warns that they can also slow your device 
down. My attitude is to simply delete them, but if you are 
strongly attached to an app that’s written in 32-bit, then 
go hunting through the app store for either the upgrade 
or replacement. I must admit, I was much attached to 
some of my old apps, but if the software author has not 
mustered the energy to convert them then it’s sayonara 
to these great old friends. To find out which apps fall 
in this category use Settings>General>About>Applicat
ions (Fig.1). While in this list, tap on an app and it will 
generate an alert confirming that the app will no longer 
work (Fig.2). Go to the app itself and try to activate it 
by tapping, and a further warning will be generated 
confirming the same information (Fig.3).
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Fig.1 - After upgrading to iOS11, many apps may no 
longer work

Fig.2 - Tap on any app in the list to bring up this alert

Fig.3 - Tap on app so affected to bring up this alert

The New Interface
In this article I am focussing on the iPad. Apple has made 
the point that when iOS10 was introduced, most of the 
important changes impacted on the iPhone rather than 
the iPad. In the case of iOS11, the reverse is the case and 
efforts have been made to upgrade the appearance and 
utility of the iPad. Nevertheless many of these changes 
also apply to the iPhone, but because of the smaller screen 
will appear somewhat different.

Control Panel
To see the changed control panel, just flick up from the 
bottom of the screen. Everything is now presented on 
the one single screen (Fig.4). If we look first at the RH 
column of icons in detail you have a block at the top. Tap 
and hold to expand into a descriptive explanation of what 
each icon does (Fig.5). In this block you can turn airplane 
mode on or off, mobile data on or off, activate or de-
activate the current wi-fi network, switch Bluetooth on or 
off, change the nature of air drop and turn your personal 
hotspot on or off. One down from this is the sound panel 
(Fig.6) where you can follow the progress of a track that’s 
playing, stop/start, go forward to the end or back to the 
start and change the volume of play. In the next block 
down, control both brightness (Fig.7) and sound (Fig.8) 
by sweeeping up or down on the exposed lozenge.

 

Fig.4 - the control panel now appears as a single entity 
in iOS11
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Fig.5 - Status of the top block of icons LHS in 
Fig.4. Touch any to reverse status

Fig.6 - Tap on music immediately below for 
volume, stop/start, advance/back controls

Fig.7 - to control brightness, 
swipe up or down

Fig.8 - To control sound, swipe 
up or down

Figures 9 and 10 display the 
activated forms of silent mode 
and do not disturb. While 
both actions suppress sounds 
emerging from your device, silent 
mode allows the device, and 
particularly the iPhone to vibrate 
and provide a silent yet distinct 
signal that an incoming message 
or advice has been received. 
When you activate this condition 
a message appears at the head 
of this column of controls, but it 
is transitory, fading quickly and 
disappearing. That is why my 
image in Figure 9 is not terribly 
distinct. It appears and fades 
quickly. I snapped it on the fade. 
By contrast, if you invoke Do Not 
Disturb then you will receive no 
sound and no vibration.

Contents

http://www.ausom.net.au


www.ausom.net.au AUSOM News December 2017 v 29

The device shuts down the advice of all incoming messages. 
As with silent mode, activation generates a message at the 
head of the control column, also transitory, but just a little 
less so. More particularly the message tells you until when 
Do Not Disturb remains active (Fig.10). In Fig 10 it says 
'Do Not Disturb: On Until Tomorrow, 7:00 am'.

Fig.9 - Activating silent mode

Fig.10 - Activating Do Not Disturb

The next control in the panel is screen mirroring, which 
enables you to project an image or video to a larger screen 
via Apple TV or its equivalent (Fig.11).

Fig.11 - Screen mirroring control

At the bottom left of this set of controls is the timer 
(Fig.4). When you tap this it opens ready to set the timer, 
but also offers controls at the bottom (Fig.12) for world 
clock, alarm, timer, stopwatch and a new facility, bedtime. 
World clock in particular has quite a fancy display 
(Fig.13) with information about sunset and sunrise and a 
moving shadow of the night, which I find quite welcome.

Fig.12 - Tap timing control (bottom left) to bring up 
world clock, timer, alarm, and bedtime

Fig.13 - World clock with its fancy displays including the 
moving night shadow (top)
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The last in the set, bottom right, is the camera (Fig.4). 
Tap this for the wide range of camera options depicted in 
Figure 14. The magnification option is difficult to see so 
I have arrowed it and developed some magnification for 
a bigger picture of my glasses. The controls on the RHS 
of the image are conventional to earlier versions of the 
camera function.

Fig.14 - Tap camera control for a wide range of camera 
options

Fig.15 - Add and modify existing controls through 
control centre settings

In this iOS Apple is keen for you to have a sense of 
freedom, to be able to express yourself, so it has made 
a lot of the controls customisable: you can add controls 
instead of simply accepting the defaults of iOS, and 
you can modify those controls that exist. Do this using 
Settings>Control Centre>Customise Controls and 
simply enjoy yourself thrashing about. If you add so 
many controls that they won’t fit, iOS11 will oblige by 
splitting the controls into groups, which become sideways 
scrollable (Fig.15).

Closing Down Apps from the Control Panel
For this return to Figure 4, which showed the control 
panel. However to the LHS four apps are displayed: Mail, 
Photos, Apps Store and Settings (Fig.16). To close any or 
all of these apps down, simply press each and swipe to the 
top of the screen when they drift out of sight, signifying 
that they have been closed. If I swipe, say, Apps Store and 
Settings up and out of sight to close these apps, then other 
apps, already active, move in from the left to take their 
place (Messages in Fig.17).

Fig.16 - Images to left of control panel are apps currently 
in service on iPad
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Fig.17 - Swipe Settings & Apps Store up to close and 
other active apps move in from left

Dock now holds many more Apps at a time
The dock at the bottom of the screen now holds many 
more apps than before, nine in fact (Fig.17). These apps 
remain in place even when you have closed the app 
down, but they are displaced as you bring other apps into 
activity. A feature that is not new, but is worth noting, 
is that above the dock is a group of faint white dots, 
which indicate the page of apps that you are looking at. 
As you move from page to page by swiping, the dot that 
represents the page order will glow more strongly. 

Recording activities on the iPad as a 
Playable, Saveable Video

Fig.18 - Screen recording activated in Control Centre 
shows new arrowed tool

Fig.19 - Tap Stop recording button to end recording 
process

Now this is a first for Apple. To switch this feature on 
(default is OFF), in Figure 15 tap Screen Recording, which 
will move from the lower group to the upper group and 
take the red minus, to remove it when you wish. When 
you now swipe up to look at your control panel, there will 
be an additional button, arrowed in Figure 18. Tap this 
and you get a THREE countdown after which recording 
commences. Once you’ve completed your recording (or 
run out of patience) tap the Stop Recording option shown 
in Figure 19. There is also an option for microphone audio 
should you need it. I made a trial recording that worked 
perfectly. This can be a real assistance for demonstrating 
to a class, though expect to have to work through it 
manually for your students to catch the subtleties of your 
exposition.

Lock Screen and Notification Centre now 
combined
Apple has unified the Lock Screen and Notification 
Centre experience in iOS11 with the latter renamed as 
the Cover Sheet. It uses your lock screen wallpaper. To 
access the cover sheet, swipe down from the top of your 
iPad when your reminders, news, twitter feeds and sundry 
other shards of information are combined together by 
day (Fig.20). Today’s reminder tells me that I should have 
visited the Balwyn Community Centre two days earlier. 
Thereafter follow a succession of tweets that I seem to 
have inherited by not ducking quickly enough. Thankfully 
I received none from President Trump. To read any one of 
these, just tap it and the news item will appear. Tuesday’s 
twitter feeds appear at the bottom of Thursday’s list (I’m 
still trying to work out what happened to Wednesday) 
and you can remove these by tapping the circled X when 
it changes to CLEAR. One tap and Monday’s notifications 
appear. Remove this and you are confronted by Sunday’s. 
Once I had cleared Saturday’s, peace reigned again. Whilst 
the lock screen only displays recent banners, the cover 
sheet will always show the full list of notifications.
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Changes to Apps
There have been many changes to the appearance of 
app logos. Contacts now features a shadowed man and 
woman of equal height rather than a single individual. 
The App Store logo is updated and Siri has a new voice.

Drag and Drop in iOS11
This is a significant development. It has broad application 
over the range of activities on the iPad and escapes the 
need for copy-paste actions.

For example you can launch new apps into Split View by 
dragging their app icons, either from the dock or from the 
Home Screen onto a display already on the iPad (Fig.21).

Fig.20 - Lock Screen and Notification Centre combined 
and renamed the Cover Sheet

For example if you have Safari in full screen and you want 
to open Calendar, then you can achieve a split view by 
pressing the Home Button or use the five-finger pinch 
gesture to return to the Home Screen. Now locate the 
Calendar icon, hold down on it to start dragging and with 
another finger, probably using two hands, reopen Safari 
by tapping on its icon, but do not let go the Calendar 
icon. Now drag the Calendar icon to the right edge of the 
screen and release. It will snap open. iOS will enter Split 
View mode with Safari on the left and Calendar on the 
right (Fig.22).

Drag and Drop is much more sophisticated than this 
example. For example, you can pluck out a weblink from 
Safari and drop it into an email that you are composing. 
Similarly you can drag and drop images from Photos 
into emails directly. Organise your emails into separate 
inboxes by just dragging them around. You can move 
multiple items at once, as in moving several photos into a 
new album with a single action.

Fig.21 - To develop a split view, first bring up a screen, 
as with this in Safari

Fig.22 - Using the method described in the text, drag 
and drop Calendar on to it

All these are essentially iPad-oriented changes. Drag and 
drop exists on the iPhone too, but items cannot be moved 
between applications like they can with the iPad. 

⌘
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Brad Smith

�

I wrote to Pam, our illustrious editor, asking if she would 
like an article describing my experience on purchasing the 
much-revered iPhone X (Ten). Pam said ‘yes’ and wished 
me luck. There was no standing in a queue this time, it 
was an online order. So it was the quick or the dead!

I’ve sat in line before and it’s a miserable experience. Made 
even MORE miserable for the people behind us who 
missed out.

I’d been advised to make sure the Apple Store App on the 
iPhone was up to date, with all details entered. Not sure 
why, there wasn’t any suggestion that preference would go 
to orders from this App. Perhaps bandwidth was better 
and the software could cope with more orders at once 
rather than the www.apple.com/au store

So it seemed like every day of the week that orders were 
going to open, I filled and re-filled my details into that 
App, over and over, so I knew I could do it quickly.

The Friday that orders opened, finally arrived. I had my 
iPhone charged and ready and my iPad charged and ready 
as a backup.

Of course, when anybody logged into the Apple Store 
looking for iPhone X, there came the dreaded “We’ve got 
something exciting to show you, so get ready. We’ll be 
back shortly.” This screen went on and on.

There was no way out except to press the home button 
and clear the screen.

In their magnificence, Apple opened the Ordering page at 
6.01pm here on the East Coast of Australia.

But of course, this is where the Gremlins came in. 6.01pm 
came and went, so did 6.02 and 03. Still, that dreaded 
screen kept coming up. Two of us were trying to battle this 
ordering, neither being successful.

Then “Wait, I’m in!” (not from me, I might add) I ran 
down to the other end of the house to see how the 
ordering was going, when suddenly it got stuck on a page 
and kept reloading over and over. Disappointed, I went 
back to my iPhone, but then, I gazed in amazement. I had 
finally entered the Order Page. All that filling over and 
over must have helped because my order went through 
with no problems. I was even able to order a second 
iPhone.

Slight disappointment when the delivery date was 10 days 
later than the promised Nov. 3rd, but the phones were 
ordered, at least.

Now…to sell the house and pay for it!

Wireless Charging? Yes or No...
All the new iPhones are coming with wireless charging. 
This means you can place the phone on a purpose built 
pad and it charges automatically through the glass back of 
the phone. Even cars have wireless charging pads now. Just 
put your phone on the pad as you drive and it magically 
charges before you get to your destination.

BUT… you cable your phone to backup and sync it to 
your iTunes account, don’t you? Every day if possible. 
Most people plug the phone into their Mac and it syncs 
and charges whilst they organise dinner. So, if you charge 
your phone via the cable regularly, then it’s difficult to see 
the need for wireless charging.

The only other reason would be if you ticked the box to 
sync the phone over WiFi. Then the charging and syncing 
remain cable free. But you’ve still got the power cable 
from the charging pad to the power point and the pad 
itself. Perhaps it’s simpler to stick to the old routine and 
keep the car charger for the “Whoops, I forgot to charge 
the phone”.

⌘
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Isabel Collins

The Upgrade — Part 5�

Nose to the Grindstone
It took me four solid weeks to wade through my 
Documents, Movies, Pictures, Music, Applications 
and Home folders and organise them. Although I 
normally store my files in a fairly logical order I tend, 
while working, to go overboard with saving duplicates: 
screenshots, information, extra bits and pieces and 
Google images – and then don’t tidy up when a job is 
finished.

After the ‘kruft’ was deleted I checked my applications 
and utilities. The ones downloaded via the App Store 
tend to be updated automatically, while the non-App 
Store applications and utilities needed updating by 
visiting individual developer sites to make sure they were 
the latest 64-bit versions. A few had to be discarded as 
it wasn’t worth the cost of upgrading compared to the 
amount of use they would get. Before the spring-clean 
the space on my new Mac’s SSD was down to 39GB and 
after the work was done I was pleased to see a healthy 
170 GB. A duplicate of the clean volume (about 80GB) 
was transferred to the external Hard Drive (EHD) to sit 
alongside the ‘junk yard’ (the untouched original 450 GB 
from my old Mac).

Joe Kissel’s ePub book, ‘Take Control of Upgrading to 
High Sierra (1.1.2)’: https://www.takecontrolbooks.
com/catalog, has been invaluable and is quite easy to 
follow for someone like me who’s not very technical. 
Joe gave me confidence and kept me focussed on the 
work that was necessary but tedious. I prefer to use my 
Mac for creative things and don’t usually look ‘under 
the bonnet’ in case I muck things up. So I was a little 
concerned when he strongly recommended creating a 
bootable back-up of Sierra by using either ‘Carbon Copy 
Cloner’ or ‘SuperDuper!’ so that if things should go 
wrong it would be easy to start up again using the Sierra 
operating system. I wasn’t at all confident as I followed his 
instructions.

I remembered I had used SuperDuper! in 2012 so I 
hunted through a few EHDs for an old backup that 
contained the ‘SuperDuper!’ application. I couldn’t 
find either an installer or the password. Eventually I 
found a screenshot that showed the date I purchased 
‘SuperDuper!’ and the serial number. What a relief! I 
decided to bite the bullet and download the latest version 
of ‘SuperDuper!’ from the ‘ShirtPocket’ website.

With fingers crossed, I typed in the serial number. It 
worked! I expected the new version would be expensive 
and was pleasantly surprised to find that once the 
application has been purchased it can be updated free 
of charge for ever. How ethical is that in these days of 
monthly drip feeds?

Before I used SuperDuper! to create a boot copy, I 
removed almost everything off the new Mac. I just left the 
Sierra operating system and a few necessary items plus 
the application and utility folders (both separately backed 
up on the EHD).

I found another EHD that I wanted to use for the bootable 
drive. I found out how much free space the volume had 
by selecting its icon in the Finder and choosing File >Get 
Info. The window that appeared showed the volume’s 
Capacity (total), Available (free), and Used space. Then 
I used Disk Utility to partition it and create a separate 
110GB EHD. With the empty drive ready and waiting 
SuperDuper! was super easy to use and very soon I was 
testing the boot copy of my Sierra hard drive to ensure 
that everything worked OK before the upgrade.

At Joe’s insistence I now had more than enough backups. 
The 1TB EHD now contained:

1.	the clean version of all the files to be transferred back 
to the Mac after the upgrade;

2.	the working copy I’d been using to update everything – 
that was now also clean and tidy;

3.	the ‘junkyard’ volume including all my old applications;
4.	a backup copy, the cleaned up applications and utilities.

All this took up about 800 GB of space. Plus, there was the 
bootable Sierra backup on the second EHD.
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High Sierra install
The final decision I had to make was whether to do an 
‘in-place upgrade’ or a ‘clean install’. Finder and Preview 
had been a bit annoying in Sierra– not responding at 
times and having to be ‘Force Quit’ – although not nearly 
as bad as the trouble I’d had when my old Mac was using 
Mavericks. I did consider a clean install. With Mac in a 
pristine and almost empty state it would have been easy 
to simply let High Sierra make a brand new start. In the 
end I took Joe Kissel’s advice and decided on the in-place 
upgrade followed by a manual refurbishment using the 
files from the backup on the EHD. I can always go back 
and do the clean install later if necessary.

After all the hours and weeks of preparation the High 
Sierra upgrade was rather a let down. The installer took 
about 1 hour and 10 minutes to download. Once this was 
finished (and to save having to download it again) I made 
a copy and transferred it to the external hard drive for 
safety.

If the installer is kept in the applications folder 
it disappears as soon as the installation is 

complete.

Then I clicked the install button and it was all over in 
another 45 minutes. Apart from the new ‘High Sierra’ 
desktop picture everything appeared to be working the 
same as before. The next day I transferred my clean 
folders back from the 1TB EHD to the Mac.

Of course it’s not the same – there is a new technology 
at work under the bonnet and as expected there are a 
few glitches as the new Apple File System (APFS) slowly 
embeds. I’m keeping a note of the “hiccups” but I expect 
Apple and all the beta testers around the world are 
working on perfecting this major change to the MacOS.

There is nothing that has caused me pain so far – even 
dear old ‘iWorks’09’ is working well. Yes, I still prefer to 
use that version even though I’ve had to make a few slight 
changes with the way I use it. I’m really pleased that Apple 
have kept it going. By the way, if you want to use ‘iWorks 
‘09’ with ‘Sierra’ or ‘High Sierra’ you will need an original 
‘iWorks’09’ install disk, which I have, and I’m happy to 
share it with any member who needs to borrow it.

Goal achieved
In 2001 I bought my first Mac for its graphics capabilities 
– all rather clunky in those days compared with the 2017 
versions – and for some years now I’ve felt the ceaseless 
progression of technology was leaving me far behind. For 
a long time I had quietly wished for a new Mac but never 
expected it to happen once my finances were confined 
to a pension. And now by some turn of fate I’m lucky 
enough to have my new Mac – with everything clean and 
updated and raring to go.

It has been an interesting and educational journey to get 
from June – when I was using Mavericks on an old Mac 
that suddenly died – to today when I’m using a new, clean 
Mac using High Sierra. The cherry on the cake is that I 
can now use my Mac for the creative things I enjoy.

While sorting through my applications I found many I 
haven’t used for ages. They’ve sparked my imagination: 
like ‘ArtRage’, which is a quality art package first 
purchased in 2008 and upgraded in 2013. Since then I’ve 
not had much time for it. Because of High Sierra I’ve had 
to upgrade to ArtRage 5 and am now very keen to get 
going with it to create backgrounds for my animations. 
Now I can REALLY enjoy being an Apple user.

Thanks for reading this far. I hope your silent wishes 
come true and your Christmas brings happiness.

⌘

Pam Doughty

Tables in Notes�
Available High Sierra and iOS 11 - this article used iOS.

The Notes app has been improved in High Sierra and iOS 
11 by allowing the creation of tables. 

In iOS 11 tap the Plus icon followed by the new grid icon 
that appears in the formatting bar.

Adding and deleting rows or columns to the table is 
achieved by tapping three vertical dots to the left of the 
row or the top of a column (circled in image below). 

Once information has been entered to the first cell you 
can move to subsequent cells by tapping enter using the 
on-screen keyboard.

⌘
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Ivan Radywonik: cozzak@me.com

Cozzak’s Corner #22�

My Top 10 Finder Tweaks
To finish off the year here’s a list of some of my favourite 
finder tweaks and tips. The default settings in a new user 
account tend to hide or minimise many useful features in 
MacOS — Apple’s quest for a squeaky-clean interface can 
leave users feeling frustrated and impotent as we try to 
perform even the most mundane tasks on our Macs.

Please take the time to check out the list below — and if 
you feel I’ve omitted something that really ought to be 
included, do let me know and I may write another list, of 
reader’s favourites.

And remember, you must actually be in the Finder for 
these to work — if you do not see the word ‘Finder’ in the 
top left of your screen (next to the Apple logo), you need 
to click on an unused space of your desktop or on the 
smiling Finder icon on your Dock.

So, in no particular order:

#1 Use the Go Menu
From the finder Menu Bar, click on Go to reveal a list 
of shortcuts to frequently used folders, such as Home, 
Downloads, Applications etc.

#2 Add the Home Folder to Finder Window 
Sidebar
From the finder Menu Bar, click on Finder >Preferences 
>Sidebar and tick the checkbox next to your Home folder 
icon (lots of others there, also).

#3 Show Scroll Bars — Always
Open System Preferences >General and tick Always 
to display scroll bars in relevant apps without them 
disappearing on you.

#4 Add Text to Toolbar Icons in Finder 
Windows
Right (Control) Click (or Trackpad two-finger tap) a 
vacant spot in the Toolbar area of any finder window and 
click on ‘Icon and Text’.

#5 Alter Text Size for Finder Windows or 
Desktop Icons
To change the size of text for finder windows, open a 
finder window by clicking on the Finder icon in the Dock 
or from the finder Menu Bar, click on File >New Finder 
Window. From the finder Menu Bar, click on View >Show 
View Options and click on the drop down menu for Text 
Size to select the size you want.

To change the size of text associated with Desktop icons, 
click on an unused space of your Desktop, then from the 
finder Menu Bar, click on View >Show View Options as 
above.

#6 Show Path Bar and Status Bar in Finder 
Windows
From the finder Menu Bar, click on View >Show Path 
Bar, then repeat the same process for Status Bar. At the 
bottom of your finder windows will be displayed the 
directory path of the selected item as well as the status 
of the selected folder or volume i.e. number of items and 
available space on the volume being used.

#7 Show All Filename Extensions
From the finder Menu Bar, click on Finder >Preferences 
>Advanced and tick the first checkbox ‘Show all filename 
extensions’.

#8 New Finder Windows Show ‘Home’
From the finder Menu Bar, click on Finder >Preferences 
>General, click on the drop down menu for ‘New Finder 
windows show’ and change it to anything other than ‘All 
My Files’ — this will encourage you to look for and save 
files in a useful manner.

#9 Declutter the Dock
Remove apps you rarely use by dragging them off the 
Dock until the word ‘Remove’ appears, or long click/right 
click an icon and select Options >Remove from Dock.

You can always replace app icons by dragging from the 
Applications folder (using the Go menu, see #1) and 
you can always open rarely-used apps via Spotlight or 
Launcher.

#10 Use MenuMeters to Monitor your Mac’s 
Inner World
OK, MenuMeters is actually a third party app but Apple 
ought to have bought it long ago. Install it to monitor 
unusual CPU or Network activity and it also provides 
easy access to both Activity Monitor and Console utilities.

It can be a little tricky to install on El Capitan and later 
but this link will help with that:

https://member.ipmu.jp/yuji.tachikawa/
MenuMetersElCapitan/

Enjoy the break and I look forward to seeing you all in the 
New Year!

⌘
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HELP @ HOME

Help @ Home is an internet-based training and trouble-
shooting initiative providing affordable service, no matter 
where you live.

From raw beginners to seasoned
  veterans, I can help you achieve
    your desired outcomes, without
 either of us stepping out of the house!

Ivan Radywonik  -  ph: 0411 336 856  or  9379 9140  -  email: cozzak@me.com

Pam Doughty

Predictive text on most Macs!�

For those who don’t have a Touch Bar there is another way 
to get your Mac to assist you with typing a word.

Sometimes when typing I’ll be trying to think how to spell 
a word — I know the first few letters then forget what 
comes next. If this sounds familiar there is a quick way to 
encourage your Mac to assist you.

In the example below I started typing ‘bus’ then pressed 
Fn+F5

Once the list is displayed you can click on the word you 
want to insert.

What Does Fn+F5 Mean?

Hold down the Function key (labelled ‘fn’ on your 
Keyboard) and Tap the F5 key (very top row of your 
keyboard) then release both keys.

If you have a Touch Bar on a MacBook Pro it replaces 
the row of function keys on the keyboard. To access the 
function keys temporarily, press the fn key which is the 
bottom leftmost key on the keyboard. You can then tap 
F5.

This tip works well if you are using TextEdit, Notes or 
Pages. It also works if you are typing within the Address/
Search bar of Safari.

⌘
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Alan Brown

Looking forward�

The Microsoft Office SIG had been held in abeyance for 
the year 2017 due to restrictions on the timetable for the 
monthly meetings at New Hope.

However this has given us time to reflect on ways 
to improve our performance. One idea has come to 
the top of the list, as it may provide us with a unique 
opportunity to attract new, younger members. Let us call 
it “Programming on an Excel spreadsheet”.

Most spreadsheet packages give the user the opportunity 
to enter data into cells, manipulate this data using 
formulas, and to plot charts of the data. A simple example 
from Excel is shown in Figure 1.

Figure 1. Plot of two line segment on a chart.

Suppose we are given the task of extending the straight 
line segments until they meet. An attempt to provide 
suitable values for the coordinates for the points C and F 
is shown in Figure 2. If both C and F are to be the point of 
intersection of the two lines, then their coordinates must 
be the same.

Figure 2. Plot of two segments after adding additional 
points

Inspection of Figure 2 quickly reveals that we have a 
wrong answer here, as only one segment is straight.

Another attempt is shown in Figure 3.

Figure 3. Plot of two segments after revising the 
coordinates for the additional points

Inspection of Figure 3 shows that we now have two 
straight-line segments that meet at a common point. 
However we have deliberately written the coordinates of 
points C and F in invisible ink! At this stage it is left to the 
reader to solve this puzzle, if they so desire.

In the Excel environment there are several ways to obtain 
a solution to this puzzle. The way that is of particular 
interest here is the use of Macros. Excel comes with a 
programming tool called Visual Basic for Applications 
(VBA). Macros can be programmed in this language to 
read the data on a spreadsheet, perform calculations, 
and write the results back into empty cells on either the 
same spreadsheet, or another spreadsheet in the same 
workbook. When the code for the Macro follows these 
design rules, there is little danger of damage to the 
computer or its hard disk.

Thus we have a safe environment in which to teach 
“coding”. There is a plentiful supply of practical problems 
from the field of geometry for the purpose of training. 
The use of charts to check the results means that the 
members can correct their own homework! “A picture is 
worth a 1000 words”.

Looking forward to next year, this plan is not just for 
the young. Existing members can choose to join in, and 
enjoy the pleasure of gaining greater control over their 
computers to solve their own practical problems.

⌘
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Isabel Collins

Christmas Ramble�

When Christmas begins to hit the stores in August I 
turn off mentally and ignore the ensuing hype until 
December. I dread ‘commercial’ Christmas and apply 
‘ProcrastinatePro’ until the last minute, mixing this each 
day (in December) with a small dose of Jacquie Lawson’s 
‘Advent Calendar’, to help me stay in “La-La Land”. All 
internet or paper junk mail referring to Christmas goes 
immediately to the recycling waste bin. However I do 
make a small effort with Christmas cards – I buy them 
with certain intent – but they never seem to reach the 
post in time so are saved for ‘next year’. And each year 
I pray my friends will still be alive to receive them. My 
only compromise on ‘pre Christmas events’ is that I love 
to sing in a Christmas choir then join in the ritual of the 
midnight service. However until 24th December I mostly 
hope and pray Christmas will just go away. Dream on...

The ‘La-La Land’ fog begins to lift a few days before 
Christmas and is replaced with a sense of doom as the 
usual Christmas conflict pops into my thoughts – “join 
the mob or do it alone”. The mob always wins and the 
sudden lurch into reality has me phoning friends to 
remind them of my existence and I accept their kind 
invitations to join them for Christmas.

Christmas Eve is always busy as it occurs to me that I’d 
like to wake up in a clean and tidy house on Christmas 
morning. So I start by playing Christmas music to get me 
in the mood. An hour or so later I finalise my list of what 
needs to be done. The number of jobs doesn’t fit into the 
rest of the day but I do the best I can. 3pm finds me at the 
local shopping centre where I get ‘commercial’ for an hour 
or so and buy small gifts and far too much food. (I’m still 
drifting in and out of the La La Land fog). On arriving 
back home I unpack and prepare for tomorrow then go to 
the midnight service. The day ends with me going to bed 
very late in a reasonably tidy house and with a happy soul.

Christmas morning means an early start to prepare lunch 
for an elderly friend who’d been going to spend Christmas 
alone. Yes, I’d promised to cook lunch – roast chicken 
with all the trimmings – while she promised to provide 
tinned fruit and ice cream for sweets. Why on earth did I 
dob myself in for the wrong side of the bargain?

Christmas music continues throughout the morning as I 
desperately cook and wrap presents and worry about what 
to give those friends I forgot to buy presents for (who I’ll 
be seeing later in the day).

When I leave the house I start feeling calmer. The rush-
hour roads are packed with everyone travelling to lunch 
with everyone else. Our quiet but happy lunch helps me 
to relax into the spirit of Christmas Day proper. It is the 
calm before the storm.

In the late afternoon I travel, in rush hour again, to more 
friends. This time it’s a large family gathering including 
various relatives I haven’t seen for quite a while. Many 
very noisy small children of various ages are rushing 
frenetically about and playing with their new toys – 
noisy weapons of mass destruction. Ears drums that is, 
earplugs, should be mandatory for guests. Meanwhile the 
adults try to ignore them as we shout over the deafening 
row and catch up on what’s been happening since we last 
met. Obviously they’ve been busy creating families.

Christmas dinner is as formal as it can be with a bunch 
of children sitting at a small table to one side – eating 
like animals despite attempts at behaviour modification 
by frazzled parents. The large table is well decorated and 
inviting, and the food is plentiful, beautifully presented 
and delicious. We pull our crackers, put on paper hats, 
groan at the silly jokes, drink a glass of champagne 
and another of red. I try to convince my stomach 
into believing it hasn’t eaten for days and have second 
helpings. After sweets we exchange gifts but the best gift 
for me is just to spend Christmas Day with the people I 
care about.

When I arrive home I’m exhausted and fatigued and 
can hardly move – due to not enough exercise in the 
preceding months, too much Christmas Eve housework, 
a lack of sleep, not enough fresh water during the day and 
far too much food. I fall mercifully into bed and sleep, 
thankfully, for hours.

Waking late on Boxing Day morning I smile and say to 
myself, “Well, that was a lovely Christmas”.

I love Christmas – when it’s all over.

⌘
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Monty Maizels

App — uzzlement�

A great deal may be said in praise of Benjamin 
Franklin. As Father of a Nation, he sure has produced a 
commendable number of offspring over the generations 
since 1776. However, his lightning conductor enterprise 
never really succeeded, since it has proved impossible 
for any successor to reduce a performance of Beethoven’s 
Ninth Symphony to a few seconds. He may be forgiven 
this, since dear Ludwig was only 6 years old at the time 
and not quite ready to tackle his masterpiece. However I 
am not quite as enchanted with another of Ben’s brilliant 
ideas, that of removing letters from existing words in the 
English language — a labour-saving device intended to 
save all of mankind a mere couple of strokes of a quill pen 
and help to delay the attrition of the goose population on 
at least one portion of our threatened planet. However, 
in his reformative zeal the man was notably inconsistent. 
While reducing his fellow Americans’ sense of humour by 
16-2/3% (to “humor”) he omitted to make a similar 12.5% 
excision of the “u” that responds to “laghter” which may 
account for so many TV shows not being fnny. (Are u not 
with me yet?)

Even stranger is the unilateral decision, thankfully not 
adopted elsewhere in our global scientific community, to 
remove an “i” to produce “aluminum”. It demonstrably 
had no effect on the efficiency of producing the metal 
from its ore, bauxite, (“bauxte”?) and was consequently 
not extended to any other elements in the Mendeleev 
table so we have been spared the inconsistencies of helum, 
lithum, sodum, calcum, radum, uranum — u name ’em. 
The Church of True Science may seem to plod in its path 
towards discovery but the rigours of research do tend to 
preclude the adoption of short-cuts that get us no closer 
to ultimate truths while saving mere milliseconds.

The Temple of Technology on the other hand has no such 
restraints or, indeed, conscience. While it may enrich our 
language with many acceptable neologisms, it sometime 
wounds it beyond recovery. Not content with tossing 
out a single superfluous letter from accepted words, it 
eviscerates them as remorselessly as the reductive process 
that strips aesthetic qualities from an uncompressed 
music file. “The mountains laboured and brought forth 
…” — the .mp3.

In this, I feel that labour-saving technology has taken 
one giant step too far in the wrong direction when it also 
intrudes into our language and destroys its universality. 
In the same way that we expect both Government and 
Church to stay out of our bedrooms, I demand (with 
as little expectation of success) that The Temple of 
Technology get off my tongue, my current objection being 
to the imposition of the universal “app”.

I presume that this is yet another wonderful efficiency 
mistakenly imposed on us all — for our own benefit, 
of course — by our American second-cousins-twice-
removed. Labour-saving? I’ll say! (as they would say). If 
this baby-talk word is a substitute for “application”, then 
what a great service has been bestowed upon us. We are 
being spared the effort of writing not a mere one, but a 
whopping EIGHT letters; and of vocalising a full three 
syllables. WOW! In my gratitude, I hardly know how to 
spend the time saved, nor in which shop. I do know that 
I shall not readily be joining the congregation to worship 
this new god which seems like a concentrated copy of 
Shiva the Destroyer — and that’s its good manifestation.

In devoting myself to meditation on my own heretical 
reactions, I have been able to develop mental strength 
and stamina through exercising my abbs, which you may 
note as my own facile abbreviation for … “abbreviations”. 
And “app” is just yet one more. But does it convey the 
full music of what one needs to express when playing the 
exciting competition sport known as communication?  
I invite you to join me now, as I use as many apps as I 
can from the store I have acc (umulated) and use in full 
almost every day. Each will be followed by a number 
in brackets, indicating how many letters we have both 
saved in making this transaction. Please count them … 
along with all your other blessings. And have a Merry 
Christmas. (for which “Don we all our gay app (+4) is an 
app (+8) example.

You’ll find the missing letters on Page 44.

*•*•*•*•*•*•*•*•*•*•*

I app(+5) this section to further demonstrate my app(+5) 
to a solution of a problem I find all too app(+5). I do 
not wish to app(+3) over-critical, but I confess that I 
would find this dumbing down, if carried to excess (as 
in tweeting), absolutely app(+6). I app(+3) to your finer 
feelings and ask you to realise that I have no app(+5) 
for upsetting the app(+6), nor, having app(+6) myself 
as champion to this cause, will I easily back down to 
app(+4) any opponents. If, having app(+6) my case, you 
find that you app(+4) of my motives, then I hope you will 
show your app(+9) with a round of app(+5).  I shall then 
be emboldened to app(+7) myself to some mystic guru 
in the App(+8) Mountains for app(+10) two years and 
meditate further there,gazing at the scenerywhile astride 
my App(+6).

If not, then perhaps it will be the High Sierra.

*•*•*•*•*•*•*•*•*•*•*

Remember those missing letters are on Page 44.
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Pam Doughty

Ask Siri�

Often members say they have recently saved a file but 
simply cannot remember its name.

Try asking Siri.

Yes, I know it does — at least at first — seems strange 
talking to your Mac. 

Give it a go. There are some things that are quicker and 
easier to just ask.

I clicked the icon circled in the image below and asked Siri 
to “Show me the Files I’ve worked on this week”

Above is the result.

⌘

Pam Doughty

Rename files or folders 
while saving
I believe the following has been possible since El Capitan 
however I only recently found out how useful it could be 
for me.

When saving a file using the “expanded” File >Save 
As dialog box (i.e. after you’ve clicked the little arrow 
alongside the filename so you can see your files and 
folders — Circled and marked 1 in the image below), you 
can right-(control-) click any file or folder and select the 
option to rename it. No need to interrupt your work and 
return to Finder.

I recently found this useful when I was saving a series of 
images that I was naming Image A, Image B etc. Suddenly 
I realised that the image I needed to save should have 
come before Image B. I was able to rename the existing 
Image B as Image C then save my new image as Image B. 
All without moving away from the Save dialog.

I did notice that I could NOT use this feature if I was 
using Icon View (Circled and marked 2 in the image 
below). Both List and Cover Flow views allowed the 
various right-(control-) click options.

Below I used Save As... however, the options are also 
available when saving a new document using the Save 
command. I also use it when downloading from the 
Internet. I have preferences in Safari to 'Ask where to 
download each file'.

I was initially unsure about 'trusting' this method to 
'Move to Trash'. However, I did try it by selecting a file I 
was sure I did not want and was happy that the file was 
correctly moved to the trash.

As yet I have not been successful in selecting/using Quick 
Look from the options available.

⌘
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Photo Ops
Continued from Page 22

Adjacent to the work area was a 
“gallery” of finished pieces for sale. 
Here’s a sample of what was available. 
A kookaburra 

four magnificent pieces 

 a wolf 

a koala 

a striking pose of a thinking man 

)

a framed owl 

just hibernating 

Ned Kelly 

the one that didn’t get away 

and an Indian motor cycle just 
waiting to be ridden home 

Due to the lead time from the 
AUSOM News deadline and some 
ops, (up to nearly three months) it 
is advisable to do some research to 
check places, dates and times.

Please Advise Photo Ops for 
February AUSOM News to 
keithbishop@outlook.com

⌘
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Brad Smith

Behold! The Long Awaited Day Arrives!�

When Apple announced the 10th Anniversary iPhone X 
(Ten) way back in September this year, anticipation grew 
and grew with the company’s loyal fans. The November 3 
release was a LONG time to wait. Would it be worth that 
wait? Only time would tell. And your bank balance.

At EXACTLY 6.01pm on Friday October 27, we put our 
details into the Apple Store App on the iPhone and iPad. 
Rumoured to be the best chance of getting first dibs on 
the phone.) 

Some succeeded, some didn’t. You only saw your deliver 
on the final order screen. November 3rd wasn’t long to 
wait, after all.

It took me about 2 minutes to get through to the Apple 
store. I ordered my phone and then ordered a second 
phone, about 3 minutes later.

Delivery for my iPhone was November 13. Two minutes  
made a BIG difference in delivery days. But it didn’t 
matter, I was happy that I was successful at least.

The delivery day arrived. The doorbell rang and there 
stood the smiling Startrack courier with the magic parcel.

I cleared the bench and placed the box in the middle, like 
the holy grail. The packaging was superb, of course. The 
phone couldn’t move; it was strapped in.

I opened the box and peeled the layers of plastic 
protection from the phone. My first reaction was one of 
concern.

It felt so FRAGILE. The glass front and back justified the 
cover I had purchased earlier.

Although the X was a little smaller in size, the new screen 
without the home button or top blank section, was huge. 
The resolution was also beautiful. Swiping took a while to 
get used to. But facial recognition was a great innovation.

Data transfer from the old phone to the new, was 
straightforward. Apple have designed a new ‘Hold this 
phone over your old phone and wait for instructions’. It 
finalised the setup by connecting to my backup in iTunes.

The cameras are different and take amazing photos. Go 
into your Apple store and have a look at the iPhone X.

⌘

Read Brad's article on page 33 telling of the ordering process 
and thoughts on wireless charging

Contents

http://www.ausom.net.au


AUSOM & AUSOM News on the Internet44 v AUSOM News December 2017

Isabel Collins

Sudoku 8�

Monty Maizels

Solution to app-uzzlement�

See the app-uzzlement on Page 40.

Appended, approach, apparent. Appear, appalling. 
Appeal, appetite, applecart, appointed, appease. 
Appraised, approve, appreciation, applause. Apprentice, 
approximately, Appalachian, Appaloosa.

(You have saved 103 letters. Spend them wisely — I have 
wasted almost one thousand words, merely proving that 
one picture would have definitely been better!)

app-alling

App-alachian mountains

App-aloosa

app-aratus

app-arel

app-arent

app-arition

app-assionata

app-eal

app-ear

app-ease

app-ended

app-etite

app-lause

app-lecart

app-liance, -lied

app-ointed

app-ortion

app-raised

app-reciation

app-rentice

app-roach

app-rove

app-ropriate

app-roximately

⌘

Editor's Note: Monty provided the following work sheet 
(from the Macquarie dictionary). Only the words shown 
in bold below were left unused.

This is a medium level Sudoku. 
Every Sudoku has a unique solution that can be 
reached logically. Enter numbers into the blank 
spaces so that each row, column and 3x3 box 
contains the numbers 1 to 9. 

Solution: next month. 

⌘

If you LOVE Sudoku puzzles perhaps you 
might use the example above and make some 
to play with your grandchildren. The 'symbols' 
could be their favourite pictures.

— Editor
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Peter Emery

November Crossword Solution�

The URL for the folk who do it online is:

 https://crosswordlabs.com/view/ausom-nov2017

Across

2. Electronic book or Apple laptop

3. Digital currency

5. Apple-only video call

7. Free web browser from google

8. File sent with an email

10. Temporary Data Storage

14. App used to create & edit movies

15. Small 50-pin connection storage device (7,5)

Down

1. Prececessor to iCloud (6,2)

2. Internet Relay Chat (1,1,1)

4. Professional-level Apple laptop (5,4)

5. Alternative name for a Hackintosh computer

6. Liquid Crystal Display

9. Apple's web browser

11. Often referred to as ottokorrupt

12. Apple's version of Microsoft's taskbar

AUSOM NOV2017

                   

1

m   

                 

2

i b o o k

                 r  b   

             

3

b i t t c o i n  

      

4

p             l   

      o      

5

f a c e t i m e   

 

6

l     w      r       m   

 

7

c h r o m e      

8

a t t a c h m e n t

 d     r      n          
9

s  

10

c l i p b o

11

a r d  k          

a      o  u    e          

f      o  t    n          

a      k  o    m          

r  

12

d   

13

g   c    a          
14

i m o v i e  

15

c o m p a c t f l

16

a s h    

  c   n   r        p      

  k   i   r        p      

   

17

t h u n d e r b o l t   l      

     s   c        e      

     b   t        t      

     a           v      

   

18

o c r                 

17. Combined PCI-Express & DisplayPort interface

18. Optical Character Recognition

13. Apple Store tech support (6,3)

16. Portable digital media receiver (5,2)

⌘
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Compiled by Pam Doughty: editor@ausom.net.au

Help, Please�

Question:
I am using Pages and have typed a great deal of next. Now 
I want to draw a vertical line beside some of the text but 
when I try to move the line the text and other objects 
move. I cannot line it up to the spot I want.

Is there something I am missing or a simple solution?

Answer:
On Your Mac
Insert the line object from the Shape toolbar.

With the line selected visit the Arrange tab, and set Text 
Wrap to None.

Now, you can position, rotate, or expand/contract the 
line without it interfering with the nearby text or other 
document objects.

BONUS TIP

To put a border around part of your text select a rectangle 
shape and give it Fill > No Fill and a Border > Line (from 
the Style Tab. Then select the Arrange Tab and set Text 
Wrap to None.

⌘
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AUSOM Membership Application
Joining a user group, such as AUSOM, puts you in touch with 
a network of Apple users and gives you access to important 
information and support resources. With about 600 members, 
there is always somebody to help you with every aspect of 
computing and using your Apple products.
Joining AUSOM is as easy as filling out the application form 
available from our friendly and informative members who run 
the Service Desk at the monthly Saturday meetings, as well as 
the Thursday meeting at the AUSOM Mornington Group.
For your convenience — particularly our country and interstate 
members — you can go to www.ausom.net.au and use the 
Membership link to join online. Type your details into the 
form and click on the Submit button to access one of 2 secure 
payment options: Paypal or Credit Card.

AUSOM Membership Renewal
You can renew your membership using one of 3 secure payment 
options: BPAY, Paypal or Credit Card.
To renew your membership using BPAY: AUSOM’s BPAY 
Biller Code number is 209627. Use the Customer Reference 
Number you see on your emailed renewal notice.

Please note: BPAY is not available to new applicants — 
Customer Reference numbers are issued when membership is 
accepted. If you are new to BPAY look at www.bpay.com.au for 
more information.

Becoming a FirstClass Subscriber
FirstClass provides local online discussion forums for over 200 
users who enjoy this great source of help, advice and Apple 
freeware, shareware and software demos — all for just $55pa.

To join FirstClass, these are the steps you should take.
•• First you must have an Internet Service Provider (or ISP), as 

you can only connect to FirstClass via the Intenet.
•• Go to the AUSOM website at www.ausom.net.au and 

from the FirstClass drop-down menu click on 'Software 
Downloads'.

•• This will take you to another web page.
•• Locate the file ‘FirstClass Client for Mac OS X — setup 

instructions’ and click on the Download button to the right 
to download the file.

•• (We recommend you print these instructions.)
•• Select the FirstClass client and the processor type that is 

appropriate for your Mac (Intel for post 2006 models).
•• To download the FirstClass Installer click on the Download 

button to the right — the installer will arrive as a compressed 
(.zip) file in the Downloads folder which can be found inside 
your Home folder.

•• Double-click on the .zip file to expand it and mount the 
image of the installer.

The Setup instructions explain point by point (with 
illustrations) what you need to do to configure the software 
and register your account on the AUSOM FirstClass server 

If you are registering for a "Trial Account" be sure to include 
this as shown in the illustration of the 

Auto Registration form. 
To pay your subscription for FirstClass follow the online 

instructions above when completing the 
AUSOM Application form.

AUSOM members may register to use FirstClass as a free 
subscription trial for one month. 

To do so follow the above instructions or write to 
office@ausom.net.au or phone 0421 126 175 

NOTE: Guest Access for SIG notes is ALWAYS available 
User ID visitorau and password peekdec16 

For Your Notes:

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

.. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. 

Retirees & Others Group – Wed. 13th Dec then Wed. 14th Feb. 
10 am–12 noon at the Baptist Church Hall 
corner Whitehorse & Parring Roads, Balwyn. (Melway 46/F8). 
109 Tram from Port Melbourne – Stop 50.
Meets the 2nd Wednesday of each month except January.
Mornington Group – Thurs. 14th Dec. then Thurs. 15th Feb.
6:30 pm–8:30 pm at the Mornington Community Information 
and Support Centre, 320 Main Street, Mornington.
Meets the 3rd Thursday of each month except January.
Everything Apple – No meeting Dec. then Tuesday 20th Feb.
2 pm–4 pm at the Melbourne PC Users’ Group, Level 1, 
479 Warrigal Rd, Moorabbin.
Meets the 4th Sunday of each month except December

Satellite Group Meetings

Saturday Meetings, next page
For Special Interest Group information see page 6.
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Room/Time 9:00-9:50 10:00-10:50 11:00-11:50 12:00-12:30 12:30-1:30 1:30-2:20 2:30-3:30

Events 
Room

iMovie 
iOS/macOS

Final Cut 
Pro/Express

Digital Film 
Festival

News@
Noon

LUNCH

iPad Coach iPhone

Function 1 Finder 
Fundamentals Filemaker Contact the 

Secretary to 
book these 

time slots for 
special SIG or 

other activities.

  

Genealogy Digital 
Photography

Function 2 Internet Plus iWork macOS 
Intermediate

Newcomers & 
Greenhorns

Meeting 
Rm 1 FirstClass Beginners GarageBand Mobile 

Multimedia

Various as 
arranged

One-on-one training is available throughout the day.
This must be booked by contacting one-one@ausom.net.au at least 48 hours in advance

Café & 
Social Areas

From 10am approx: • Member Services • Raffle ticket sales  
• Exchange Table • Social interaction • A variety of foods & drinks from the café until 2:00pm.

Room/Time 9:00-9:50 10:00-10:50 11:00-11:50 12:00-12:30 12:30-1:30 1:30-2:20 2:30-3:30

Correct at time of publication. Late changes AUSOM’s web site or timetables at the meeting.
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11	 AUSOM Monthly Raffle Ad.
11	 AUSOM Meeting Ads.
19	 Macfixer Ad.
19	 Business Card Ads.
25	 Pentagon Ad.
37	 Help@Home Ad.

Saturday Meeting Dates: Sat. 2nd December then Sat. 3rd February
AUSOM meets monthly (except January) at NewHope Baptist Church, 3-7 Springfield Rd, Blackburn North. (Melway 47/H7). 

Bus 279 from BoxHill Railway Station. See www.ausom.net.au/events/categories/main-meeting/ for location details.
Most meetings are held on the First Saturday, if public holidays prevent this then members will be notified via AUSOM's website, 

Calendar or in AUSOM News. Subscribe to AUSOM Calendar at http://ausom.net.au/subscribe-to-our-events-calendar-feed/

Saturday Meeting Timetable
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